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Executive Summary

Ambient Intelligence will be an essential part of the next-generation Internet of Things (loT).
loT-NGIN aims to provide a set of components, modules, and methods to enable Ambient
Intelligence and Contextual loT Sensing / Actuating in a set of relevant use cases and living
labs, assisted with Augmented Reality (AR) presentation and interaction methods and tools.

This deliverable reports on the contributions of IoT-NGIN in that direction, within the scope of
its Work Package 4 (WP4) “Enhancing loT Tactile & Contextual Sensing/Actuating”. In
particular, the main outcomes of this deliverable include:

e A comprehensive state-of-the-art review on Ambient Intelligence via |oT-AR.

e An update of the technical specifications and interfaces for the final.yersions of four
key components developed within WP4 o enable the envisioned Use cases, namely:
loT Device Discovery, IoT Device Indexing, loT Device AcgesssControl, and loT
presentation and interaction.

¢ Final implementation details for the above-mentioned cemponents and tools, for
each foreseen Living Lab and Use Case.

¢ Installation and user guidelines of the tools for the above-mentioned components and
tools, and links to their open-source code on GitLab.

In addition, a set of open access IoT-AR resources, botideveloped within the project, as well
as third-party ones, have been gathered to let the,interesfed audience build their targeted
AR app or tool, allowing rich interation with a diverse set’of multi-modal IoT environments.

This deliverable reports on the final version of the technological contributions from WP4, so its
content can be more comprehensively €omiprehended if read in conjunction with its
predecessor deliverables (D4.2 and D4.3),“which reported on the requirements for each
component and use cases, initial and, updated designs for all envisioned tools / components,
as well as the developments of specific components, like 0T Device Discovery, loT Device
Indexing, and loT Device Access Confrol.
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1 Infroduction

Ambient Intelligence will be an essential part of the next-generation Internet of Things (loT).
loT-NGIN aims to provide a set of components, modules and methods to enable Ambient
Intelligence loT in a set of relevant use cases and living labs, assisted with Augmented Reality
(AR) presentation and interaction methods and tools. This deliverable reports on the
contributions of I0oT-NGIN in that direction, within the scope of its Work Package 4 (WP4)
“Enhancing loT Tactile & Contextual Sensing/Actuating”. The main outcomes reported in this
deliverable include:

o Comprehensive state-of-the-art review on Ambient Intelligence via |oT-AR.
¢ Updated technical specifications and interfaces of the final versions ofthe four main
components developed within WP4 to enable the envisioned use gases, namely:

o loT Device Discovery (IDD), which is responsible for_recognition and/or
positioning of loT Devices, with a key focus on Computier:Vision based image
recognition in this deliverable.

o loT Device Indexing (IDl), which manages deviee-€lated information and
supports Digital Twin functionality.

o loT Device Access Control (IDAC), which intervenes communications among
loT-NGIN components and devices and provides configurable multi-criteria
access control.

o 1oT-AR, which is responsible for presentation of, and interaction with, the loT
sensors / devices.

e Final implementation details for the abovespientioned components and tools, for
each foreseen use case.

¢ Installation and user guidelines of the toolsfor the above-mentioned components and
tools, for each foreseen use case,.and links to their open-source code on GitLab.

In addition, a set of open access [oT-AR fesources, both developed within the project and
third-party ones, have been gathered fo let the interested audience build their targeted AR
app or tool, allowing rich interactionwith a diverse set of multi-modal loT environments. All
such resources are collected in Annex 1 and on a Wiki at the project’s Gitlab [1].

This deliverable reports on,fhe final version of the technological contributions from WP4, so its
content can be morescomprehensively comprehended if read in conjunction with ifs
predecessor D4.2 [2] and D4.3 [3] deliverables, which reported on the requirements for each
component andruse<Ccases, initial designs for all envisioned tools / components, as well as
developmentsofispecific components, like IDD, IDI and IDAC.

1.1 Inteded Audience

The'target audience of this deliverable includes mainly 10T system providers, engineers and
AR, developers and/or technical staff, who would be interested in developing ambient
intelligence and contextual sensing / actuating in loT systems. Through this report, in
combination with D4.2 and D4.3, they may identify the relevant ambient intelligence
requirements in application domains covered by the 10T-NGIN Living Labs and Use Cases
(UCs), and find the technical specifications and concrete implementation for all associated
components related to IDD, IDI, IDAC and |oT-AR presentation and interaction.

Furthermore, most of the developed tools and components are publicly shared, so they can
be downloaded, tested and fine-tuned based on the specific purposes.

13 of 96



H2020 -957246 - IoT-NGIN
loT-NGIN

D4.4 - Enhanced loT Tactile & Contextual Sensing/Actuating (Final Version)

Moreover, the report is useful internally, to the members of the development and integration
team of the [I0T-NGIN consortium, involving mainly WP3-WPé partners, the Living Lab teams
from WP7, but also to the whole Consortium and third parties, especially those participating
via Open Calls, for integration, validation and exploitation purposes. Useful feedback could
be also received from the Advisory Board, including both technical and impact creation
comments.

1.2 Relations to other activities

The activities of WP4 are strongly connected to the rest IoT-NGIN activities, as sketchﬂ?\

WP9: Project Management & Open Calls Coordination

1oT-NGIN Technology Development O

=
o
c
0
2
(]
C
[0
O
=
()
z

Requirements & Meta-
Architecture

WP1:

__________________________________________

WP8: Impact Creation &

' Outreach
@gure 1. Work packages structure

Table 1 describes The;e re:to’rionships with further details.

Table 1. Relation of WP4 activities to other WPs and tasks

WP1 The definition of the Living Labs’ UCs and elicitation of user/system
requirements has served D4.3 and D4.4 for the (updated) definition of
the IoT Ambient Inteligence components implemented in tasks T4.2,

T4.3 and T4.4. Also, the role of the tools and modules deployed in WP4
are represented in the meta-architecture resulting by the activities in
WP1.

WP2 No direct interaction is foreseen among WP4 and WP2. WP2 provides
communication enhancements which  could support the
communication requirements for tactile communications in next-
generation loT.
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WP3 The training and sharing/serving of Artificial Intelligence (Al) models of
the loT Device Discovery components can be conducted via the
Machine Learning as a Service (MLaas) platform developed in WP3.
Moreover, deployment of Al models into physical devices may be
passed via the Digital Twin functionality of the IDI module.

WP5 The IDI and the IDAC modules deployed in WP4 interact with different
components developed within the scope of WP5, such as the loT
Vulnerability Crawler. Moreover, IDAC integrates the Self-Sovereign
Identities module.

WPé6 WP4 components will be integrated with the rest,_of\ project’s
technologies and frameworks within WP6, while some, of“the WP4
components may be used in the development of application logic for
the use cases or the Open Calls.

WP7 WP4 components have been implemented ahd used in several Living
Labs and Use Cases (UCs), as reported in D473.

WP4 supports 3@ parties by offering a specificsset of functionalities (such
as the IoT-AR repository).

WP8 WP4 provides notable outcomes and results for supporting impact
creation activities. Moreover /it ‘\considers feedback (e.g., from the
market analysis and business modelling tasks), which could be relevant
for the WP4 design and development.

1.3 Relations to previpgssdeliverables in WP4

Deliverables in WP4 are somehow, iterative, although they have been planned to minimize
the amount of redundance, just repeorting on new or evolved aspects and/or contribution in
every new recent deliverable.NJable 2 summarizes the relation of D4.4 compared to previous
WP4 deliverables, in particulér D4.2 [2] and D4.3 [3].

Table 2. Relation of D4.4 compared to previous WP4 deliverables (D4.2 and D4.3)
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D4.2 D4.3 D4.4
State-of-the-art Object Brief SOTA analysis on AR | In-depth review of |oT-
(SOTA) on Ambient | recognition AR
Inteligence  and Object
Tactile loT posiﬂoning
Device

Requirements from
UCs

WP4 architecture

WP4 Modules

loT Device

Discovery

loT Device

Indexing

loT Device
Access Control

AR/MR

Implementation in
the LL

Smart Agriculture

Industry 4.0

authentication
5G

Edge
computing

Initial
requirements

User stories

Initial
description

Initial
description
Initial interfaces

Initial
description
Initial interfdces

Initial
desgfiptien
Initicakinterfaces

Initial

description
Initial interfaces

Update of the
requirements

Updated descripfion
Updated'déscripfion
Updated description
nterfaces update
Updated description
Interfaces update
Updated description

IDD Presented
IDI Presented
IDAC Presented
AR Initial

IDD Initial

IDI Noft started
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Already covered in
D4.3

Updates on the
implementation of
interfaces

Already covered in
D4.3

Already covered in
D4.3

Updated description
Updated Interfaces

IDD Updated

IDI Completed
in D4.3

IDAC

AR Completed

IDD Completed

IDI Completed
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IDAC Noft started | IDAC Completed
AR Initial AR Completed
Smart Energy IDD Initial IDD Completed
IDI Initial IDI Completed
IDAC Initial IDAC Completed
AR Noft started | AR Completed
Smart City - (IDI & IDAC use presented | (IDI &=, IDAC use
in WP7) presented in WP7)
Installation IDD Not started _-IDD«EV) | Completed
guidelines (Computer
Vision, CV)
IDD  (Ultra | Presented IDD Completed
Wideband( (UWB) in D4.3
UWB))
IDD (Visible Presented IDD Completed
Light (VLP) in D4.3
Positioning,
VLP)
DI Presented IDI Completed
in D4.3
IDAC Presented IDAC Completed
in D4.3
AR Not started | AR Completed

1.4 Docdument overview

The restof the document is organized as follows.

Sectlion 2-provides a comprehensive state-of-the-art review on Ambient Inteligence and
Contextual Sensing and Actuating via loT and AR technologies, as a motivation of the work
conddcted under the umbrella of loT-NGIN, and its WP4 in particular.

Section 3 provides a short summary on the functionality of IDI and IDAC as tools towards
developing digital twins, and reports updates regarding the specifications of the interfaces
and APIs for loT-AR components/modules, compared to the ones reported and described in
D4.3 [3].

Section 4reports the implementation of the Al-based object recognition methods specifically
for the Smart Agriculture use case and of all associated AR apps and methods for the Smart
Agriculture, Smart Energy and Industry 4.0 use cases.
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Section 5 provides the installation and usage guidelines for the components described in
Section 4.

Finally, Section 6 summarizes the conclusion and the next steps toward the implementation
and validation of the pilot actions for each envisioned use case.
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2 State-of-the-Art on Ambient Intelligence via
|lOT-AR

An efficient combination of, and coordination between, AR and IoT technologies makes it
possible to bridge the real world, virtual world (i.e., digital content), and ambient
environment (i.e., information from loT sensors), thereby increasing the richness of information
and opening up new possibilities for context-aware ambient inteligence application
development.

In addition, AR technologies have become an excellent means of providing richmulfi-modal
applications and services, in ferms of input modalities, output modalities, and intferaction
modalities (Figure 2), thus expanding the possibilities provided via classical Information
Communications Technology (ICT) systems / services [4].

Input Modalities

Sensors Visual signal Sound  Tangible object

n @ & oY
u ioi

Visual graphics  Sound Haptics Sensors Interaction

Biosignal

Agent ;
Output Modalities  System

Figure 2. Overview of output and input modadalitigs to interact with ICT systems and services

The applicability of AR-enabled interactionsystems in the 1oT ecosystem is diverse, including
relevant use cases and scenarios, such, as: monitoring environmental sensors; smart farming,
smart manufacturing or smart cities; application for virtual visits, etc.

Hereafter, a review of state-of-the-a’works and studies involving AR and loT technologies is
provided as proof of relevance of the wide applicability and the diverse set of challenges
and opportunities availabledh this domain.

Up to date, many scientific studies and surveys have deeply analyzed the joint potential of
loT and AR technologies (e.g., [4]. [5]. [6]. [7]. [8]). exploring potential use case scenarios,
and assessing associdted technological challenges.

The study in [9] joroposed the use of AR as immersive analytical tool for maintenance tasks,
with a key focUs on improving the safety of workers and supporting their decision making.

The work ini{10] infroduces the use of AR as a support to loT data visualization. The proposed
loT-ARsystem superimposes data from |oT sensors onto real-world objects, supporting object
interaefion (see Figure 3). The system includes a low-cost multi-camera sub-system,
connected to Internet, which allows an accurate measurement of the 3D coordinates of the
target objects for displaying the associated information in the appropriate location and
perspective, avoiding visibility issues, and for a richer interaction. The system is applied in a
smart precision agriculture use case to monitor crops in an environmentally sustainable,
natural, and comprehensive manner, and its potential and benefits are highlighted
compared to classical visualization and annotation methods.
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Figure 3. Example of visual repreon methods assessed in [10]: (a) virtual text with semi-
fransparent layer; (b) aCube with color fo visualize the loT information

information through per; modalities (e.g., visualizations, sounds, vibrations) from data
sources that may be u@ce vable (e.g., readings from sensors or signals, ratings of a service
from other users).

The work in [11] highligh’r% R has become a promising technology to provide useful
ivab

The study in [7]¢§iss?us/ses and highlights the potential of providing a synergistic integration
between loT , by providing a literature review on three key aspects, and identifying
still remaining ‘ehallenges and opportunities for each of them: (i) distributed and object-
centric d anagement (including for AR services); (i) loT object-guided tracking; (iii)
seom@ raction (especially with complex artifacts) and content interoperability.

The study in [12] analyzes up to 79 works (published from 2000 to 2018) having used loT and
ARtechnologies across a wide set of platforms and use cases. It reveals that over 60 of the
proposed solutions utilized vision (light) as input and output modalities, while other modalities,
such as sound, touch, motion, and temperature, were used in less than 20 of the proposed
solutions in these works. Similarly, the study in [13] analyzed up to 14 works (published from
2014 to 2018) having proposed multimodal interaction systems using AR. From these works,
eight input modalities (gesture, speech, face, touch, adaptive, motion, tangible, and click)
were identified.

More recently, the study in [4] provides an in-depth review of twenty three (23) studies that
have proposed multimodal interaction systems combining IoT and AR technologies, as a
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proof of evidence of the huge diversity and possibilities in this domain. That study also reflects
on the need forinteroperable and open components, modules, interfaces and architectures
to support such a diversity of input, output and interaction modalities, which in turn motivates
the interaction, communication, processing and AR developments from |oT-NGIN, many of
them reported in this deliverable.
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3 Ambient Intelligence in IoT-NGIN

This section provides a brief summary of WP4 components supporting the development of
Digital Twins, namely IDI and IDAC, and reports on updates regarding the specifications and
interfaces of loT-NGIN lIoT-AR modules.

3.1 Converging to a Digital Twin solution

A Digital Twin (DT) can be seen as a virtual representation of a physical entity, which may be
used for extracting context or knowledge about the physical entity operation infreal time or
predicting its behavior under changing circumstances without intervening withithe actual
physical entity. Functionally, DTs are used for supervision, interaction, and prediction of assets
with significant benefits arising from the capability of querying and interactingwith the digital
representation, even in cases that it would be impossible or impraciical to do so with the
physical asset.

DTs have been first infroduced by the aerospace industry and have been revolutionary in
that area, as tests regarding new parts have been made pessible on DTs, without the risk of
damaging the physical equipment in case of test failures. The.application surface for DTs has
been significantly extended since their initial occurrence, providing similar benefits in a
number of domains, such as other Smart Industry, Smart;City, or Smart Energy use cases,
among others.

The realization of a DT can be leveraged by. loT, Al and advanced analytics, as well as
advanced visualization technologies, but dlsodmmersive technologies such as AR. [oT is a
significant driver, enabling monitoring thexstatusof the physical asset and enabling creating
context around its operation. Al and @analytics have also a strong share of the predictive
capability of the DT. Indicatively, sophisticated Machine Learning (ML) models may be
leveraged to predict potential failures, based on real-time data coming from the physical
asset, while mathematical models may well simulate the asset’s behavior and help decision
making under different what=if<scenarios. In addition, (3D) visualization facilitates the
perception of the asset stGtys @and possibly its placement in its environment. Last, but not
least, immersive technologies ahd formats, like AR, provide enhanced interfaces for human-
DT interaction in the context of building human-centric applications or symbiotic human-
machine systems.

DTs provide obViously significant benefits in many relevant industries. However, they are
application ana asset-specific, so there is no single solution or technology which may address
the challengesin every application domain. A DT is a combination of fechnologies, which
additionally,comes with challenges for its effective realization.

A speaifie.challenge relates to the quality, appropriateness or even format of data collected
and used by the DT to infer the asset’s situation. Collected data must be usable by the DT,
which/means that they represent the necessary asset properties and are of sufficient quantity
and freshness in order to create credible context. Moreover, interoperability is important, as
the DT might need to integrate information from multiple sources with diverse interfaces.

Moreover, security must be ensured at the connection points with both the devices and
querying entities. Each endpoint represents a potential security vulnerability, which may
allow cyber-attackers take control of the DT and thus cause damage even to the physical
devices.
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Within WP4, these two challenges which relate with the data collection and security of
bidirectional interfaces of the DT are addressed through the IDI and IDAC components.

Both IDI and IDAC have been presented in D4.3 [3], reporting their final specifications.
Updates and fixes are being applied since then on the basis of the feedback received from
the deployment in the context of the |IoT-NGIN use cases.

Next, a short functional description of each component is provided.

3.1.1 loT Device Indexing (IDl)

The IDI module is used to connect to |oT devices, collect their measurements, keep,their DT
appropriately updated as well as keep arecord of the changes in the data, Theseomponent
also supports the communication of commands to the device via its DT. The IDI component,
as depicted in Figure 4, consists of the following sub-components:

e FIWARE Orion Context Broker (Orion) [14], which is used to steredherlatest updates of
an loT device's data. Orion holds a Next Generation Seryiee Interfaces v2 (NGSIv2)
representation of the device's data. An external user canguerythe data of the device
without directly interacting with the device itself or can.even pass commands through
the component.

e FIWARE IloT Agent [15], whichis used as a way fordevices to communicate with Orion,
in cases they have not adopted the NGSIv2 representation for their data. The loT
Agent receives the device's data in their native communication protocol (HTTP,
Message Queuing Telemetry Transport (MQTT), etc.), makes the appropriate
transformation and passes the NGSIV2 representation of the information to the
Context Broker. An important feature of the IoT Agent is the usage of two mandatory
headers, which are used to implementthe multitenancy [16] feature.

e Historic Data Registry [17]. SineenOrion does not by default hold the changes that
occur in a device's data, the~Historic Data Registry is used to keep a record of the
changes in the data. The structure of the Registry keeps in line with the multitenancy
architecture of Orion and the'oT Agent. The Historic Data Registry communicates with
Orion through its natification mechanism [18]. A subscription to receive nofifications
has to be made forithe Reqistry. Depending on the different tenants and for which
devices arecordisdesired to be kept, there could be multiple subscriptions that need
to be created.

e Inactivity Checker [19], which is used to determine whether a device is new (has just
been registered) or not, as well as its activity status. The activity status is determined
for all theg’ available devices, based on their last update.

The component is available as open source on the H2020 I0T-NGIN group of the public
GitLakfinstance [20].
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Figure % ce Indexing - functional description

3.1.2 10T Devi %cess Control (IDAC)

The IDAC module handles the access to the resources of the IoT-NGIN project. It is responsible
for the protection of services and the authentication and authorization of users. It employs
an Applicati rogramming Interface (APl) Gateway which applies multi-criteria resource-
centred controls on requests for IoT-NGIN resources, before forwarding the requests to such
involved ﬁ?ﬁces. Moreover, IDAC implements criteria-based controls in the form of
inde enht pluggable modules, which can then be selected to be applied in each
re@ not. IDAC's high-level architecture is depicted in Figure 5.
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Figure 5. High-level architectufe gf the IDAC module.

In IoT-NGIN, the Kong Gateway API [21], anepen-source project that enables the use of a
variety of security methods, like oauth [22] and jwt tokens [23], has been adopted. In
particular, the following custom plugins haveseeen implemented in IoT-NGIN:

e Proximity: A plugin that enablés ambient intelligence based protection. It compares
the distance between thesdevice of a user making a request and the requested
device and, if it is lower than a configurable threshold, it allows access.

¢ Keycloak: A plugin that.enables Keycloak authentication for both public and private
clients.

o S3SI (Self Sovereigmldentities): A plugin that enables authentication based on the
Privacy Preserving/SSI component.

The module also uses the Konga Graphical User Interface (GUI), an interface for Kong that
allows quick and\easy management of the Kong services and plugins.

The component is available as open source on the H2020 I0T-NGIN group of the public
GitLab instancen24].

3ANET-AR Modules

An in-depth overview of the scenarios and requirements of all IoT-NGIN UCs making use of
loT and AR technologies has been provided in Section 2 of D4.3 [3], namely: Smart Agriculture
(UC #4); Industry 4.0 (UCs #6 #7); and Smart Energy (UC #10).

On the other hand, D4.3 [3] provided a comprehensive overview of the communication
workflow (in Section 3) and associated interfaces/protocols/messages (in Annex 1) between
the I0T-AR components and the associated IDI module for: (i) discovering information
updates; (i) being provided with periodic updates; and (i) actuating the status of the
registered sensors therein. This is summarized in Figure 6. In addition, Section 3 of D4.3 [3] also
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provided an overall picture of the development frameworks, underlying scenarios and AR
devices to be used in each of these loT-AR use cases.
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Figure 6. High-level sequence diagrams for AR presentatigffand actuation cases.

The implementations of the loT-AR modules and assogidted apps have closely followed the
specifications and designs reported in D4.3, which are detailed in Section 4. This subsection
just briefly reports on those specifications and intetffaeesof the 10T-AR modules for Industry 4.0
and Smart Energy UCs that have realized slight changés compared to D4.3.

Industry 4.0 (#UC6)

The unique modification compared to what Was reported in D4.3 is that the usage of MQTT
as communication protocol with the IDInodule, which was indicated as an alternative and
feasible option in D4.3, has been disregarded after having detected some incompatibilities
with some of the features provided by the IDI. Thus, all features and interfaces have been
implemented via API REST pratocol, Which was also identified in D4.3 as a valid (and already
tested) alternative.

Industry 4.0 (#UC7)

The AR application for #8C7 was initially planned for training, sales, manufacturing, and/or
maintenance scenariés. All potential purposes were explored, and maintenance-related
scenarios were‘selected for further development.

The specification for content and access control have been refined and slightly redefined.
In addition te.the 3D model of the cabinet (.fox), the dynamically retrieved data now
includesymadel target files (.xml and .dat) and model component metadata files (.wri and
Xls). As™the data is proprietary, access control is necessary to restrict access to only
althorized parties. A proprietary Identity and Access Management (IAM) service is used for
thisspyrpose. QR-code scanning and decoding for identifying the cabinet are done locally
on the display device, and cloud service is not required.

Smart Agriculture (#UC4) & Smart Energy (#UC10)

While the specifications and interfaces were reported in D4.3, they have been customized
for the real implementation in the different Living Labs as part of the Smart Energy and Smart
Agriculture UCs.
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This section reports on the design specification for the mobile phone AR app, combining Unity
and Vuforia, including a seamless integration with all involved components of the 10T-NGIN
ecosystem.

The mobile phone AR app covers both the Smart Agriculture and the Smart Energy LL. Both
of the apps working with the same architecture, and they change only on the sensor to be
detected and also in the fact that the mobile AR app in case of the Smart Energy is equipped
with a further functionality that enable the actuation on the sensor. The focus lies in
developing an AR app that enhances the user experience by overlaying digital information
onto Electric Vehicle (EV) charging stations and Synfield devices / sensors. The F%N
objective of this app is to provide users with real-time insights and contextual in ion
about sensors, bridging the physical and digital worlds, paving the way forinear-future
interaction between EV user and charging station via smart glasses/smart co tlenses. In
general, the implementation involves the Unity 3D environment, creating i @ targets using
Vuforia as QR codes, establishing communication channels with S services, and
seamlessly overlaying digital information onto real devices / sensors. %
bi

Figure 7 sketches the component diagram and interfaces for ’rh@

AR module / app
for both the Living Labs. Q

Request Interface 15

Takes Object Immage

Request Interface: 11
- Response interface: |1
-

Response inferface: 12

A

Request Interface 13

Response interface: I3 -

A

Request Interface: 12

Figure 7. AR module and interfaces for #UC10
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Figure 8 provides a comprehensive sequence diagram to depict the dynamic and temporal
aspects of the implementation and how the different modules/interfaces interact.

Takes a picture (or video) of a Sends a Picture of a Charging Station H H H ;
charging station L (or video streaming) ‘ I
" g Request Sends a Picture of a Charging Station (or video) i
Discovery Device I
 Send AR response for Charging Station Discovered Device by Machine Learning (x. y and % in Json format)
(anchor boxes, percentage object detected)fll 4
Request Sends a Picture of a QRCode
(or Video)
Required Access (user, pw)
Ml hpcn il ed 48
Access granted
RS
Request Glet Record ID Device associated a QR code 2

Index Device < Response measurements of the Device ID from the Digital Twin: Historical Data
Send AR response for QRCode I

App." superimpose data on real image”
such as for example:
1D Device, percentage Charge, efc...)

<

Request "Actuate" command
(for example-on/off Charging Station)

Response "Actuate” command

Figure 8. Sequence diagrgm=ehAR module interactions for #UC10

Next, a concise description of the=APRIs incorporated in the final architecture of the AR
modules as specified in Figure %, ag well as an overview of the interfaces utilized for
communication between the differédt components, are provided.

Interface [1: Connection APl tothe MLaas for Device discovery

The Device is identified by the AR app using MLaaS, which results in the recognition of a
specific entity, such as amEV Charging Station. This recognition is visually represented on the
mobile phone by displaying an anchored edge, depicted as green anchor boxes.

The AR app dhitiates a call to the MLaasS service, providing an image of the Device and
received the inference outcome as a response. This inference outcome is processed by the
AR app, ‘génerating a surrounding context based on the geometric coordinates.
Addifionally, the inference outcome provides a value that enables the determination of the
deteeted object's providing also the accuracy of classification as a percentage shown on
the frame.

Interface 12: Connection API to IDI

The invocation of this interface enables the ufilization of the IDI component, which operates
behind the IDAC component. By sending requests to Access Conftrol's Keycloak-protected
endpoints, users can access the indexing services provided by devices. This facilitates the
retrieval of information on the devices' DTs, including the desired measurements of interest,
such as sensor-detected data.
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Interface 13+15: Redlization of the "Actuate Command" (At least for the "Charging Station" in
Smart Energy UC)

This APl enables the display of an 'Actuate Command' on the mobile phone. When the user
clicks this button, the application invokes an API to perform ON/OFF (i.e. start / stop) actions
for the EV Charging Station, tart / stop a charging session. This APlis made available by EMOT
(manager of the EV charging station).

Finally, Table 3 summarizes the defined and used APIs by the AR module for the #UC10.
Table 3. APIs defined and used by the AR module for the #UC10

APl | Request/ Protocol | Method Expected Input Expected Output
Response
[ Request REST POST Image (.joeg) or video
frames
Response Fle dYson (X,Y for
dnchor box and %
Discovery)
12 Request REST GET ID Device
Response - Refrieve information

about the digital
twins of the devices
(ex: % or Volt of the
charging process)

I3+l | Request I3 | REST GET ID*Device ON/OFF  of the
5 Charging Station
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4 Implementation for the IoT-NGIN Living Labs

This section provides a description of the new implementation or improvements of WP4
components toward the realization of the Living Labs, for each specific UC. It should be
noted that the section is exclusively focused on those components for which new
developments have been provided, since D4.3 [3] was delivered.

4.1 loT Device Discovery (IDD)

IDD modules were implemented for three of the Living labs. In each of them, a spedific IDD
module / method was configured to detect a different type of device, as summarized in
Table 4.

Table 4. Discovery methods and objects to be detects in the I0T-N&IN LivinG Lalbs

Living lab Discovery method Objects discovered
implemented

Smart Agriculture Computer Vision SynField device

Smart Energy Computer Vison Charging station

Industry 4.0 Computer Vision People, Autonomous Guided

Vehicles (AGV), carts

Ultra Wide Band (UWB) AGV
Visual Light Rositioning (VLP) AGV

The next section explains how the computer vision method of the IDD module has been
implemented for the living labs of Spaart Agriculture and Smart Energy. In addition, a short
description of how the IDD madule has been implemented in the Industry 4.0 use case can
be found in section 4.1.2, ‘although the detailed description of the implementation can be
found in D7.3 [25].

4.1.1 Al-bgsed Object Recognition for the Smart
Adlletture & Smart Energy UCs

Generdhinfo / Requirements / Installation

Theé mainh objective is to develop an Al-based object recognition model able to detect the
Synhelixis SynField loT devices as well as the EMOT EV charging stations from photos taken by
mobile devices in the field.

For this purpose, a methodology and framework were developed and followed to build the
model described next.

The pretrained model ‘EfficientDet D1 640x640' [26] was selected and ‘TensorFlow object
detection API' was used for the training purposes. TensorFlow object detection API is a
framework for creating deep learning networks that solve object detection problems. There
are already trained models but were customized for the Living Lab use cases using the
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pretrained network weights for the ‘EfficientDet D1 640x640'. The architecture of the model
is shown in Figure 9.

Class prediction net

...............

..............

~ A
~ 2 AN

AR -
;

N o

Box prediction net

.............

P/4 BiFPN Layer

EfficientNet backbone

Figure 9. EfficientDet architecture

EfficientDet uses ImageNet pre-trained EfficientNet architegture, as a backbone. The
proposed Bi-directional Feature Pyramid Network (BiIFPN) serwes as the feature network,
which takes level 3—-7 features P3, P4, P5, P6, P7, from the backbene network and repeatedly
applies top-down and bottom-up bidirectional feature fusion. These fused features are fed
to a class and box network to produce object [lass, and bounding box predictions
respectively. The class and box network weights aré shared across all levels of features.

The output of the model is the detection of the required objects [Synelixis SynField device or
EMOT EV charging station]. The whole progess/f setting up the model, the required APIs,
how the input photos were labelled and how we carried out the training process is detailed
below. The model has been built in pythen.and requires the following packages:

e Python 3.8+
¢ Anaconda

Installation Setup

The initial setup was splitinte’é sections:

Workspace & Training Files Organization
Preparation/annotation of image dataset
Record generation

Training Ripeline configuration
Training'and monitoring the model

6. Expartresulting model object

N

Workspgee structure

The structure of our workspace is defined by the directory tree in Figure 10.
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training_demo/

f— annotations/

I~ exported-models/
— images/

[ test/

“— train/

models/

FAFAE T T OF

pre-trained-models/
README .md

Figure 10. Directory Tree of workspace
An explanation for each of the folders/files shown in the above tree isprovided next:

e annotations: This folder was used to store all *.csv files and the respective TensorFlow
*.record files, which contain the list of annotations for our datasetimages.

o exported-models: This folder was used to store exported versions of our trained
model(s).

e images: This folder contains a copy of all the images in‘our dataset, as well as the
respective *.xml files produced for each one via the labéling engine ‘Labellmg’. More
details are provided in the next section.

¢ images/train: This folder contains a copy of allimages, and the respective *.xml files,
which were used to train our model.

e images/test: This folder contains a copy of'\dll images, and the respective *.xml files,
which were used to test our model.

e models: This folder contains a sub-folder for each training job. Each subfolder contains
the training pipeline configuration file *:eonfig, as well as all files generated during the
training and evaluation of our mMedel.

e pre-trained-models: This folder, contains the downloaded pre-trained models, which
were used as a starting checkpoint for our training jobs.

¢ README.md: Thisis an optionalfile which provides some general information regarding
the training conditions ef our model. It is not used by TensorFlow in any way, but it
generally helps when you have a few training folders and/or you are revisiting a
trained model after some time.

Training Methodology

The model wasbduilt in order to detect the object of interest (Synelixis SynField device or EMOT
EV charging station). The model was trained by a series of photos as well as videos capturing
the objectfrom,different angles. The input of the model is a photo of the area where the
Synelixis.SynField device or EMOT EV charging station resides. Figure 11 shows a few samples
of ountraining set.
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Figure 11. Samples of the training set fopthe Synelixis SynField device

For the SynField device, EBOS was provided with tal of 116 photos and two videos which
were processed to give 5 frames per second: The two videos have a fotal duration of 63
seconds. Cutting them in 5 frames per s@!, a total of 332 additional photos were
compiled.

ided eleven videos which were processed to give
hem were then filtered to keep only the suitable
ber of the images that were kept for the training

For the EV charging station, eBOS was

5 frames per second. The image ‘
images that were clear. The to
purposes after the initial filtra

=

0Pl

(L

Figure 12. Samples of the training set for emotion Charging Station.
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Thus, the total number of the images of both the objects of the interest were 1647. The
dataset was split into three sets. A training set, a testing set and a validation set. The ratio for
creating the above data sets was set at 90:5:5.

Dataset Preparation/TF Records Creation

The first step was to identify and annotate the photographs. There is some software available
for this purpose, and 'labeling' was selected, which can be accessed and downloaded here:
https://qgithub.com/tzutalin/labellmg/archive /master.zip

Figure 13 shows the interface of such an application.

Figure 13. Labelling Interface

An XML version of the photographs was built, by labelling them. The photos were divided into
training and test sets. A label map was required by Tensorflow, which franslates each of the
utilized labels to aninteger value. Both the fraining and detection methods make advantage
of this. The generated file was named 'label_map.pbtxt' and has the format depicted in
Figure 14.

34 of 96


https://github.com/tzutalin/labelImg/archive/master.zip

H2020 -957246 - 1oT-NGIN

leT-NGIN

D4.4 - Enhanced loT Tactile & Contextual Sensing/Actuating (Final Version)

item {
id: 1
name: ‘SynField_Box'
¥
item {
id: 2
name: ‘Charging_Station’
}

Figure 14. The label of the object.

After the photos were annotated and the datasets defined into training and testing subsets,
those annotations were converted into TFRecord format.

Model Training

The model used was not developed from scratch; instead, we wsed one of Tensorflow's pre-
frained models, EfficientDet-D1-640x640. This was saved in“the "pre-trained-models folder
created.

Some changes at the configuration file pipeline.config were performed. Changes include:

setting the number of the labelling classes (line 3). For our case it is 2.
setting the batch size (line 131): We pu#8. Thiswaries based on your system.
fine_tune_checkpoint (line 161):

o pre-trained models/ Efficientbet=-p1-coco 17 /checkpoint/ckpt-0
fine_tune_checkpoint_type (167} SetHo ‘detfection’.
use_bfloat1é: false (line 168)=Sef*this to false if you are not training on a Tensor
Processing Units (TPU).
label_map_path (lines 1723182): "annotations/label_map.pbixt"
input_path (line 174)#"annotations/train.record"
input_path (line 186).//annotations/test.record"

Once the training has started, its progress was monitored through Tensorboard [27]. The
following graphs were obtained using Tensorboard. The model was trained for the 25000
steps for the traiming. The graphs for Tensorflow are shown in Figure 15.

Loss/total_loss

Loss/regularization_loss
tag: Loss/total_loss

tag: Loss/regularization_loss

800 ‘\\ 800 4

600+ |\ 600 -

400 +

200 +

16k 20k
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Loss/localization_loss Loss/localization_loss
tag: Loss/localization_loss tag: Loss/localization_loss

Figure 15. Results from model training

The model was successfully trained and evaluated against the COCO detection metrics [28]
for each checkpoint. The checkpoint was created after each 1000 steps to monitor the
performance of the frained model. The 12 metrics depicted in Figure 16 were used for
characterizing the performance of the trained object detector.

Average Precision (AP):

AP % AP at IoU=.50:.05:.95 (primary challenge metric)
ApIou=.5@ % AP at IoU=.5@ (PASCAL VOC metric)
ApIOU=.75 % AP at IoU=.75 (strict metric)
AP Across Scales:
Aps=all % AP for small objects: area < 322
Apmedium % AP for medium objects: 322 < area < 96°
aplarge % AP for large objects: area > 96°
Average Recall (AR):
ARSX=1 % AR given 1 detection per image
ARMax=1@ % AR given 1@ detections per image
ARM2X=100 % AR given 100 detections per image
AR Across Scales:
ARs®21l % AR for small objects: area < 322
ARmedivm % AR for medium objects: 322 < area < 962
ARlarge % AR for large objects: area > 96°

L T T | I T I

]

Figure 16. Meftrics to characterize the performance of the frained model.

The COCO evaluation metrics were used to validate the performance of the object
detection tfrained model but there were few metrics that cannot be validated against as for
example, since for the analyzed case there is only one object per image that needs to be
detected and not multiple detections of the object in the same image. The prediction time
was 0.18 seconds (average) for the 24 unseen images that the model was tested on.
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Model Testing

The trained model was tested for the objects of interest and it was successful in identifying
both the Synfield device as well as the EV charging station. The detection of the model on
both objects of interest is shown in Figure 17.

Figure 17. ModeNesting

Json Format for the Model Output

The final output from the trained deteation model was the detection label of the object that
was detected as well as the confidengetscore with which it was detected according to the
coordinates of the anchor boxes,

The resultant json string hassthesfollowing fields of information:

¢ The name correspaondssdo the category that is detected either the” Synfield_Box " or
“Charging_station.

e The _nineach x, y axis names show the normalized coordinates of the anchor boxes.

o The simplé x,y axis names show the real coordinates of the anchor boxes.

4.1 ZIndustry 4.0

The three different methods of the Device Discovery module (CV, UWB and VLP) were
desearibed in D4.2 [2] and D4.3 [3] and implemented in the Industry 4.0 Living Lab, more
specifically in the #UCé "Human-centered safety in a self-aware indoor factory
environment”, deployed in the factory owned by Bosch in Aranjuez (Spain).

Each of these three methods was implemented to discover a different type of object in this
UC: (i) CV method can detect, tfrack and position people, AGVs, Tuggers, and loaded and
empty carts; and (i) UWB and VLP methods can position and track the AGV and atf the same
time they can identify particular AGVs, which is not always possible with the CV method. That
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is why these different methods can complement each other in this use case, as explained in
D7.3 [25].

4.2 |1oT Device indexing (IDl)

For the loT Device Indexing (IDI) component, no special implementation needs to be made
per use case. The component has been deployed on the Living Labs and is used for the
execution of the pilot scenarios. An example of using it in Smart Agriculture has\been
provided in D4.3 [3].

4.3 10T Devices access control (IDAC)

For the |oT Device Access Conftrol (IDAC) component, no special implementation needs to
be made per use case. The component has been deployed on the Living Labs and is used
for the execution of the pilot scenarios. An example of using it inthe Smart Agriculture and
Smart Energy Living Lab has been provided in D4.3 [3].

4.4 AR modules
4.4.1 Industry 4.0: BOSCH Fact&py

An AR tool has been designed to increase fthesafety and situational awareness in Industry
4.0 use cases. In particular, within the scepeof #UC6, the goal is to provide ambient
intelligence and context awareness by displaying the location, position and related
information about a variety of sensors and.elements (i.e., AGV, carts and persons), both static
and moving, all over the factory.

The AR tool has been developedi\towrln on a Magic Leap headset, so the worker does not
have to deviate his/her visual'attention while being provided with the |oT-AR information, as
both the real-world environment and the IoT-AR information will be displayed on the same
field of view.

A distinctive feature of the developed AR tool compared to state-of-the-art ones (reviewed
in Section 2) can be“ighlighted: it is able to display relevant and meaningful information
about sensorsfelements not only detected via its build-in AR camera, but also by other
external visudl{CV, VLP) and non-visual (UWB) IDD methods, which all work in cooperation
with the IDIFandDAC components of the IoT-NGIN platform. In addition, the AR tool is able
to proyide @ comprehensive situational awareness in the factory, by displaying a mini map
of it, withthe position of all far and close by sensors being detected inside the factory.

Thus, by using the implemented AR app, workers will be able to move safely, avoid accidents
WIthhAGVs or pedestrians, and have a comprehensive and rich situational awareness about
the elements and commodities inside the facility, as well as relevant information about them.
Likewise, managers can use this kind of information to optimize processes and boost overall
efficiency. In conclusion, an AR app like the one developed can increase operational
effectiveness and worker safety in different business sectors (e.g., manufacturing, logistics,
and retail), by offering rich, valuable and meaningful situational awareness, information and
notifications.
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The functionality of the AR tool is provided by a number of software elements that operate
in a coordinated manner: (i) Magic Leap One headset; (i) Unity, with Vuforia Engine [29];
and (iii) back-end technology that links the AR app modules to the rest of the [0T-NGIN
platform components, and also includes all other core components to provide the desired
functionalities.

Figure 18 provides a high-level overview of the software components of the designed AR
app, and its interfaces with other modules of the 10T-NGIN platform.

Two sensors are near
"

draw x,y,z

€

Update every 1 second
X,Y,Z coordinates
Using Unity Web Request HTTP Request

e

loT Sesonrs -1-

b

loT Sensor -2- loT Sensor -n-

Figure 18. High-ley®| architecture of the developed AR app for Smart Industry #UC6
Next, its main components are described.
Detection of Visual Targets

The AR app makes, use of image targets and Vuforia Engine to provide tracking features.
Image targetsiare used to detect certain markers within the environment, while Vuforia is
utilized to ayertay virtual material or information onto the real-world environment.

Theseimmage / visual targets can be strategically positioned around the physical environment
torservenspecific purposes, like obtaining and superimposing info about elements (e.g.,
products or machines in the facture) of the environment (see Figure 19, as an example), or
even as a support for device positioning in indoor (see next subsection).
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VENTRESCA DE BONITO

——,

X
B 12/2026

Figure 19. Detection of visual targets and superimposing related aformation, using Vuforia

Ad-hoc internal device positioning method for indoor scenarios

In outdoor scenarios, the position of an AR device cén be accurately known by relying on
Global Positioning System (GPS) technology. Hewever GPS is not available in indoor
environments, so alternative methods for device positioning would be needed.

One direct approach to overcome this is to frack the AR device, or the worker wearing it, by
using any of the IDD methods developed jnloT-NGIN project (i.e., CV, UWB, VLP). In addition,
an ad-hoc internal device positioning methodbased on the Magic Leap One headset has
been designed and implementeds, The Magic Leap One headset makes use of a
combination of cameras, sensors, and computer vision algorithms to accurately tfrack the
position and orientation of the headset in real-time. On the one hand, since the tracking
provided by the AR device itself islimited to a certain view, i2CAT has adjusted such a system
using a Virtual Reality (VR) €amera that follows the user in the specified trajectory to support
the device's tfracking process. The obtained data can be processed and used to determine
the user’s current locdiion in“the physical environment. Special relevance is given to the
obtained x and y coordinates (since z values will be around 1.7). On the other hand, image
targets can support ih the device positioning / tracking process. Visual markers can be
strateqically placed around the physical environment, and can be recognized by the AR
camera whénsmoving around it. After detecting an image target, the app can then
calculatehe User's position and even the associated orientation/direction. The obtained
position.coerdinated can then be stored internally and/or posted to the IDI module, as for
any other sensor/element, and can also be used to provide live or event-driven notifications
totheworker or AR app'’s user.

In addition, the position from the AR device can also be correlated and refined with the
one(s) obtained by using other discovery methods applied to the AR device or worker, so
that an accurate and reliable position can be obtained.

Communication between l1oT-AR and IDI modules via APl REST

As documented in Annex 1 of D4.3 [3], API REST communication interfaces and messages
between the |oT-AR and IDI modules have been implemented.
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From Unity, and using the Magic Leap device, it is firstly necessary to request privileges to
access Internet and to display information with low latency (Figure 20).

// Request access to the Internet. This privilege is required for applications that need to
access web services or other online resources

MLPrivileges.RequestPrivilege (MLPrivileges.ld.Internet);

// Request access to the local area network. This privilege is required for applications that
need to communicate with other devices on the same network

MLPrivileges.RequestPrivilege (MLPrivileges.ld.LocalAreaNetwork);
// Request access to low-latency lightwear. This privilege is required for ap Vﬁ
need to display content with low latency, such as AR applications Q

MLPrivileges.RequestPrivilege (MLPrivileges.ld.LowLatencylLightwear);

Figure 20. Request of Internet privileges from the Magic u

To extract the positions of 10T sensors and/or elements registered i module, Unity web
requests via API REST are sent every 0.5s. The following code s (Figure 21) shows how it
can be done in case of using a CSV file to store such an mfoeron In case of using the IDI
module, the communication interfaces are identical.

IEnumerator DownloadFile()

{ 9
while (frue) // Loop infinitely %

{
UnityWebRequest uwr =
UnityWebRequest.Get("http: 88.36.130:11000/database/test_datagtest_name=
pos_pruebo_MIA_O?—OS—X ;

Debug.Log("Downl file...");

yield return uwr.Send
if (uwr.result @
{ %

Debug rror(uwr.error);

; Debug.Log("File downloaded successfully!”);
O if (uwr downloadHandler.data.Length <= 0)

WebRequest.Result.Success)

continue;
}
csv = System.Text.Encoding.UTF8.GetString(uwr.downloadHandler.data);
Debug.Log(csv);
string[] records = csv.Split('\n');

Debug.Log(records.Length);
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// Get the last record (skip the header)

string lastRecord = records[records.Length - 2];

string(] fields = lastRecord.Split(,');

float x = float.Parse(fields[3], Culturelnfo.lnvariantCulture.NumberFormat);

float z = float.Parse(fields[4],
Culturelnfo.InvariantCulture.NumberFormat);

// Transform the location of the AGV depending always on
the same origin

AGV.transform.position = new Vector3(x, 0, z);
Debug.Log("AGV position: " + AGV.transform.position);
}
// Wait for one second before the next iteration
yield return new WaitForSeconds(0.5f);

Figure 21. Communication with IDI modulg, ff&m Unity

AR display of information about sensors/elements

The meaningful data from the retrieved informatiof (position, status...) from the IDI module,
either being the last entry or historical data from.the registry, will be shown on the AR display,
at an appropriate position and with an appropriate format.

Figure 22 shows an example from a prespilohirial at BOSCH factory displaying virtual positions
of an AGV (blue 3D model) and a person, (red avatar), together with their overall position in
the factory displayed on also anfoverldid mini map (see next sub-section). All such visual
information will be complementedwith additional info from the detected elements/sensors,
beyond their position, like speed+=oad, id, etc.

Figure 22. AR information displayed for the #UCé (Bosch factory)
Mini map display with info about available sensors
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In large environments, like a factory, it becomes very useful to get provided with an overall
and comprehensive situational awareness. For this purpose, as the Bosch factory has been
equipped with camera, leds and UWB tags in different places to detect the sensors/elements
(i.,e., AGVs, persons, carts...) from/at different parts of it, a new functionality has been
developed to provide such arequirement via the AR app. It consists of displaying a mini map
on a corner of the field of view, showing the tracked area (see green area of the map
displayed in Figure 22), and the information/position of all detected elements in such areaq,
as depicted in Figure 22. A different color and 3D model / icon is used to differentiate
between different types of sensors / elements.

The position of all sensors/elements displayed as part of the mini map is retrieved frompthe DI
module. By default, all sensors/elements are displayed, but afilter could be activated fo just
display only those sensors/elements within a pre-defined distance from the AR*device.

Alarm based on close distance (or detection of collision)

Beyond displaying information retrieved from the IDI module, the AR dpp can provide event-
driven and/or periodic visual or auditive alarms based on diffefent Sriggers: (i) distance
between any two sensors below a threshold (see code in Eiguré 23); (ii) risk of collision
between a moving sensor and an element of the factory; (iiN@ certain parameter of the
detected sensors/elements is relevant to the worker using the=AR device; (iv) a new relevant
sensor/element has been detected; etfc.

using UnityEngine;

public class DetectCollision : MonoBehayieur
{
public GameObject object;
public GameObject object2;
public string message =40ORjects are near each other!”;
private void Update()
{

Float distance = Vector3.Distance(object1.tfransform.position,
object2.transform.pesition);

// change the value to adjust the proximity threshold
if Ydistance < threshold)

{
Debug.Log(Warning!! Objects too closell);

Figure 23. Alarm system to inform about near distances between sensors
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4.4.2 Industry 4.0: ABB Factory

Overview

The aim of the AR application for #UC7 is to help field service engineers or end customers
firstly to identify and locate electrical components inside the physical drive cabinet, and
secondly to understand the functionality of those components. A drive line-up can consist of
mulfiple cabinets forming a few or even tens of meters long configuration. Identifying the
correct cabinet and then the correct components inside can be time-consuming and
frustrating. The application first identifies the individual drive unit and then dynamiacglly [eads
the 3D- and technical data related to the unique drive and its components. Thisiis achiéved
by utilizing the digital cabinet models developed within the #UC7.

The AR application consists of several components working together to prévide the user with
information upon interactions. The architecture is presented in Figure 24. The AR application
runs on mobile devices, utilizing Unity with Vuforia Engine, QR-codeg, scanning library, and
backend storing and providing the drive related data. Next thesmaincomponents of the

application are presented.

Extracted s/n Authorization request

Content request

Component -
; L User selections
visualization

Figure 24. Simplified architecture schematic of the #UC7 AR application

QR-code scahning

The drive waits 'ship with unique QR-codes from the factory. These QR-codes include a
hyperlink tofa product documentation portal. However, this portal is not implemented in this
case.lnstead, the hyperlink comprises the drive unit's serial number, which will serve as a key
input fordownstream processing. The AR application employs a third-party library to decode
the hyperlink from the QR-code, which is shown in Figure 25, and subsequently exiracts the
serial number from the hyperlink string.
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Start()

renderer = GetComponent<RawImage>();
webcamTexture = WebCamTexture(1024, 1824);
renderer.texture = webcamTexture;

StartCoroutine(GetQRCode());
}

IEnumerator GetQRCode()
{
IBarcodeReader barCodeReader = BarcodeReader();
webcamTexture . Play();
snap = Texture2D(webcamTexture.width, webcamTexture.height, TextureFormat.ARGB32,
while ( .IsNullorEmpty(QrCode))
i
try
{
snap.SetPixels32(webcamTexture.GetPixels32());
Result = barCodeReader.Decode(snap.GetRawTextureData(), webcamTexture.width, webcamTexture.height, RGBLuminanceSource.BitmapFormat.ARGE32)
if (Result != a
{
QrCode = Result.Text;
if (! . IsNullOrEmpty(QrCode))
{

Debug.Log("DECODED TEXT FRO R: " + QrCode);
break;

}

}
i
catch (Exception ex) { Debug.LogWarning(ex.Messagel); }
yield return
}

webcamTexture . Stop();

Figure 25. Code for decoding the hygerlink from QR code

Dynamic model loading

The dynamic model loading component takes the drive serial number as input and
generates then a request to the backend'service. The request triggers the invocation of the
IAM service and prompts the user to provideiogin credentials.

Upon successful login, the requestis routed to the backend service, which responds with the
3D model (.fbx), model target filesN.xml and .dat), and model part/component details (.wri
and .xls). This data is utilized togeepuldate the application’s interaction features, and to enable
tracking based on the modeNltarget files. Figure 26 shows how interaction buttons are
populated with 3D modehdatar

45 of 96



H2020 -957246 - 1oT-NGIN

leT-NGIN

D4.4 - Enhanced loT Tactile & Contextual Sensing/Actuating (Final Version)

CreateProductButtons( locationName)

List<wWri > butte List<Wr: (O
buttonData a. c.FunctionDesignation == GlobalData.LastClickedFunction && c.MountinglLocation == locationName).Tolist();

Transform[] test = GlobalData.page3.GetComponentsInChildren<Transform=();

foreach (T n transform in test)
! a = transform.name.ToString();
if(transform.name == "Content3")
! foreach (Button item inm transform.gameObject.GetComponentsInChildren<Button>())
{ Destroy(item.gameObject);

ach (WriDa odel buttonPD in buttonData.where(c => c.ProductDesignation != )]

ject model = Ga t.Find(buttonPD.ID);

m_Renderer = model.GetComponentInChildren<Me >();
1. m_Renderer == ) continue;

Ge t newButton = Instantiat .buttonPrefab, ata.buttonParent3.transform);
newButton . GetComponentInChildren< GUI>().text = buttonPD.ProductDesignation;
newButton . AddComponent<i

newButton . GetComponentInChildren<WriD 1 .ID = buttonPD.ID;
newButton.GetComponentInChildren< .Fullpt = buttonPD.FullDt;
newButton.GetComponentInChildren< .FunctionDesignation = buttenPD.FunctionDesignation;
newButton.GetComponentInChildrens< .Mountinglocation = buttonPD.MountingLocation;
newButton . GetComponentInChildren<i taModel .ProductDesignation = buttonPD.ProductDesignation;

Figure 26. Code for populating interactionfbuttons

Component interaction

Once the AR scene has been populated withloaded data and the tracking is acquired, the
GUl is enabled for the user. The GUI include$ a feature that generates component selection
buttons based on the 3D-model structurenand the user's selections. The selection path starts
from the top level, and if the chosen cemponent has child components, new selections are
generated. Once the user picks a compoenent, its model is furned visible, and a label game
object is updated with selected/component location + offset, and the label content is
updated according to the target aomponent device ID. Figure 27 provides an example of
label and highlighted compoanent:Together with component highlight, the label visualizes
the location of the compénenhwithin the physical device. Additionally, the GUI has a 2D
component to display the cepiponent technical details, if needed.
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\/

Figure 27. Example of highlighted component and componentifag on a digital cabinet model

4.4.3 Smart Agricul’rure/Energy<</CJ

Smart Agriculture

Smart Agriculture Living Lab. The testin onducted in accordance with the architecture

The AR app underwent thorough testing«ofiits core functionalities within the context of the
and component interactions outlinedy %hop’rer 3, composed of the following steps:

e Reference Image Capture @m g an Android mobile phone, we captured animage
of the SynField device as ayreference.

¢ Sending Image/Fra aas: The captured image/frame was then transmitted to

the MLaasS platfo vice detection.

e Response from @S: pon transmitting the image to MLaas, a response is obtained
as depicted in Figure 28, presented here for convenience the response message

ob’roineg\ /

'prediction': '"{\'name\': \'SynField Box\', \'score\': \'61%\', \'ymin_n\': [@], \'xmin_n\': [@],

\'ymax_n\': [1], \'xmax_n\': [@], \'ymin\': [@], \'xmin\': [0], \'ymax\': [324], \'xmax\': [0]}"'}

Q Figure 28. Call Service MLaasS of the VM

¢ The response of the MLaasS allows to create the view of the "anchor box" and the %
Discovery on the screen of the Android mobile phone (Figure 29). An example of this
message is also provided below:

"{'name': 'SynField_Box', 'score': '99%', 'ymin_n': [0.5127112], 'xmin_n': [0.6133435], 'ymax_n': [0.81261986],
'xmax_n": [0.7942085], 'ymin': [984.4055557250977], 'xmin': [662.4109554290771], 'ymax':
[1560.2301406860352], 'xmax': [857.7452087402344]}"
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Figure 29. Anchor Box e % Discovery

¢ The subsequent step involves describing the AR applicatio %bprimorily focuses
on displaying sensor information associated with the speciQyn ield artefact on the
screen of the Android mobile phone. This visualizati on the mobile phone is

achieved by first identifying the device ("ID_DEVICEY).through a QR code affixed to
the SynField device.

These AR features are achieved through these sub—sfps:

1. Creation of ".apk" files using Vuforia and Uni lications. The ".apk" file is installed
on the Android mobile phone (See the associdted “Installation and user guidelines"
subsection in Section 5).

2. When the QRCode affixed to th NnFiled sensor is framed by an Android mobile

phone, via an ".apk’" file, an AR appears on the mobile phone display.
Next, an example of the AR image.di ed on the Android mobile phone is shown (Figure
30), when, by framing the QRC data is not present (yet) on the IDI component, as
the expected values are no’r@ N the boxes.

Figure 30. AR on QRCode

1. By framing the QRCode, again via ".apk"’, the connection to the services for the IDI
componentis activated, but authentication and authorization via IDAC must first take
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please. In particular some screenshots are shown below to show part of the Results
tested on VM (Ubuntu OS), just for example:

o Figure 31: the token received for authentication (Access Control)
o Figure 32: Historical data on IDI for the last 2 records

S pipenv run python test-access-control.py

Loading .env environment variables..

Example of a token received from Keycloak:
eyJhbGci01JSUZIINLISINR5cCIgOiALS1dUIiwia2lkI1A6ICI1TONZckgwWUIWX2dtNDUtC1RVVUZWWIW11UDI3dDQ2TDRREFE4bHNISVNBING . eyJ1eHALOjE2Nzk2NZEXMTASImLhdCI6MTY30TY3MDg)|
VsYWIuZXUvemVhbG1zL21vdC1uZ2luIiwilYXVKIjoiYWNjb3VudCISINNIYLiI6IME@OTU3OTNLLWRIMGUENDIhMi04NjUZLTFhZWRhOTAkMTFIMCISINRSCCI6IkILYXIlciIsImMF6cCI6IMFjY2Vzcy1jb2]
3Mi0nsicm9sZXMi0lsib2ZmbGluzVvohy2Nlc LCI1bWFFYXVBaGoyaXphdGlvbiISIMR1ZMF1bHQtCcmOSZXMtaW9OLWSNaW4iXX0sInd1lc291cmNLX2FjY2VzcyI6eyIhY2NvdW50Ijp7InIvbGVzIjpbIni
aWQi0iI4NzY30TImNS1INDF jLTQWMWYtY jd1Z11hN2EONDB jMGE4ZTYLLCIbWFpb! JpZml1ZCI6ZMFsc2USINBYZWZ1cnI1ZF91c2VybmFtZSI6InR1c3QtdXNLciIsImdpdmVuX25hbWULOLI1LCImY|
XqscKbJ9Yg5hP3p_jnTWP6qf4y456BgqlSTom82DzyEfEyoUgk2rSNxXCj19CkWyviARsODe-D75CalULrhN8dX7fC9ITSLuctgyloaMUrov-m_kPesJOnHUhNE76awMQMfwozuk6GmMNESJY3-BLHtyH1TMgH)

Example of a token received from Keycloak:

eyJhbGciOi/SUzl 1 NilsIinR5cClg OiAiSIdUliwiaZIlkliA6ICI TONZckgwWU9wX2dtNDUtc 1 RvVUZwWWWi1iUD/3dDQ2TD
RReFE4bHNISVNBInO.eylleHAIOJE2ZNzkZNzExMTAsImIhdCI6MTY30TY 3MDgxMCwianfpljoiMZIhMmi 1 MTQINGQ
3ZS00N2M 1LWI5ODRINTImMZ2ZiMjU2Z TNhliwiaXNzljoiaHROcHM6Ly 9rZXljbGOhayspb 3Qtbmdpbi5vbm Vs YW/
uZXUvemVhbG 1zL2IvdC1uZ2luliwiYXVkijoi YWNjb 3VudClsinN 1 Yil6ImEOOTU3QTNEWRIMGUIND JhMiO4NjUzL TF
hZWRhOTdkMTFIMClsInR5cCl61kJIYXJIcilsimF6cCI6ImFY 2Vzcy 1jb250cmshiwic2Vz82lvb/9zd GFOZS16/jg 3Njc5
owY 1LWUOMWMLINDAxXZi 1iN2VmLWE3YTQOMGMwY ThiNilsImFjcil6ljEiILClyZWiEsbVOhY2NIc3MiOnsicm9sZXMi
o/

Figure 31. IDI: Get a token frgm Keycloak

[{id": "urn:ngsi-Id:Device: 1", "type": "Test’, "alias": myll[™¥p": null, "location": "38.027030, 23.732950"}, {"id":
"urn:ngsi-ld:Device: 1", "type": "Test", "alias": gulh_ 10" "null, "location": "38.027030, 23.732950"}

Figure 32. Test Historical Dagt on\IDY. requests “Get last n records/ID Device” (n=2)

Finally, the visualization of the 'ARNGpp, always after having framed the QRcode and
connecting to the services,of the 10T Device Indexing, is shown in Figure 33. It can be seen
that the values of the sensers obtained in Response and supplied by the DT are displayed in
the individual boxes of4the AR’(on a black background):

Figure 33. AR on QRCode (with the values of the sensors of the SynField node)

Next, an excerpt of the developed software including all previous steps is provided. The
complete software can be accessed and reviewed at the project’s Gitlab [30] .
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Debug.Log (request .downloadHandler) ;

using System.Collections;

using System.Collections.Genéric;
using UnityEngine;

using Vuforia;

using TMPro;

using UnityEngine.Networking;

publiciclass VBIN : MonoBehaviour
{
public VirtualButtonBehaviour Vb;
public GameObject window;

public TextMeshPro olive_fuit;

// Start is called before the first frame update

void Start()
{

Vb.RegisterOnButtonPressed(OnButtonPressed);
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// Vb.RegisterOnButtonReleased(OnButtonRelased);
Debug.Log("start");

window.SetActive(false);

public void OnButtonPressed(VirtualButtonBehaviour Vb){
Debug.Log("tes pressed");
GetData();

olive_fuit. GetComponent<TextMeshPro>().text = "Olive fruit fly [stage]:" + 64 ;
window.SetActive(true);

void GetData() => StartCoroutine(GetData_Coroutine());

IEnumerator GetData_Coroutine()

{

string url = "https://keycloak.iotngin.lab.synelixis.com/realms/iot-ngigf:-well-knoWn/openid-configuration";

using(UnityWebRequest request = UnityWebRequest.Get(url))
{
yield return request.SendWebRequest();
if (request.result I= UnityWebRequest.Result.Success)
{
Debug.Log(request.error);
Debug.LogError("errore");
}
else

Debug.Log(request.dewnloadHandler);
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Restricted Mode is mtended for tafe code browsmg Trust ths wincom 80 ensble ol festures.  Marace  Leamn More

Figure 34. Software of the AR apg’tor Smart Energy UC

Once this .apk being transferred and installed on an Android device, it will be observed on
it as shown in Figure 35.

=

m T 8 @ 1Y ® o L P 2
Figure 35. AR on QRCode

A virtual button has been added to start calling services (in this case the IDI service). When
the "more info” button is clicked, the calls starts and the interface is populated in AR.
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Figure 37./AR 6n/QRCode

This virtual button allows obtaining mare_information, to be displayed in the various boxes
present on the mobile phone display (included in the AR screen above) so as to dynamically
obtain the enhancement of the datayelating to the sensors connected, for example, to a
specific SynField device.

For convenience, next a s€éreenshot is provided to show part of the results tested on VM

(Ubuntu QOS), including thedresponse we get when a given SynField device is detected.
(Figure 38).

Loadlingsenvienvironment variables. ..

H'7d""\'7635010500003897", "type": 'Synfield", "synfield data" [{"sensing service id"™: 2599, "value": 6,
"ontime": "2023-03-26721:15:00.0089672"}, {"sensing_service_id": 939, "value": 4.13, "ontime": "2023-03-
27710:55:44.1076 132"}, {"sensing_service id": 940, "value": 22, "ontime": "2023-03-
27T10:55:44.1076 132"}, {"sensing_service_id": 941, "value": 5, "ontime": "2023-03-27T710:55:44.1076 132"},
{"sensing_service id": 942, "value": O, "ontime": "2023-03-27T10:55:44.107613Z2"}, {"sensing_service id":
944, "value": 66.3, "ontime": "2023-03-27T710:55:44.107613Z2"}, {"sensing_service_id": 943, "value": 18.7,
"ontime": "2023-03-27T10:55:44.1076132"}, {"sensing_service_id": 945, "value": 1.77, "ontime": "2023-03-
27T10:55:44. 1076 132"}, {"sensing_service_id": 946, "value": O, "ontime": "2023-03-27T710:55:44.1076 132"},

{"sensing_service id": 947, "value": 9, "ontime": "2023-03-27T10:55:44.1076 132"}, ...

Figure 38. Requests Device Index N=2 (with the values of the sensors of the SynField node)
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5 Installation and user guidelines

The source code for each one of the components and tools described in this deliverable is
available on the project’s Gitlab, and the concrete reference is provided in the respective
subsection. This section provides basic installation and usage guidelines for each of them.

5.1 1oT Device Discovery (Computer Vision)

5.1.1 Installation guidelines

The following instructions are provided to be able to execute the demo ©6f the IDD module
based on Computer Vision.

The system does not require any special hardware, although systems with-a CUDA-enabled
GPU would be preferred. As for software, it is best to have Ubuntu20.04 or Ubuntu 22.04.

The demo code for the loT Device Discovery based on Computer Vision can be found on
the project’s Gitlab [31]. For the setup and installation, the follewing steps and considerations
need to be considered:

1. Git clone
You can clone the repository using the follewing-<command.

$ git clone https://gitlab.com/pZ620-i0t-

ngin/enhancing iot tactile contiextudl sensing actuating/iot-device-
discovery/computer-vision-devie=discovery.git

$ cd computer-vision-device-discovery

2. Requirements

The demo can eithér beexecuted in the host OS using a Python Virtual Environment
or by using Docker.

a. Local execution

In_the root folder of this project there is the Pipfile file to create the virtual
énvironment.

i. Ensure that the system has pipenv installed correctly. If not, it can be
installed with pip. Note that if pipenv was installed via the apt package
manager, it should be uninstalled and re-installed with pip as the apt
version is deprecated.

$ sudo pip3 install pipenv

ii. Once pipenv has been installed, the virtual environment can be
created with the following command.

$ pipenv install
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b. Docker execution

You can also use docker to execute the demo. There are 2 images available,
depending on if you have a CUDA-enabled GPU or just CPU. In both cases

you need to make sure that docker is installed and configured properly in
your system.

— Installation instructions:
https://docs.docker.com/engine/install/ubuntu/
— Post-installation instructions:
https://docs.docker.com/engine/install/linux-postinstally
CPU only

Once docker is properly installed, the following commands.can be
used to build and run the image. The process might'take around 5-10

minutes, as it needs to download the necessary system and Python
libraries.

$ cd docker/cpu
$ ./build_image.sh
$ ./run_image.sh $PATH_TO_ROOT_FOLDER

$ cd computer_vision_demo

Note: If the docker installationsdoes not have rootless privileges, the
build_image.sh and run_imagé:sh files can be edited to add the sudo
command beforé the docker instructions.

GPU

To use this im@ge, you need to ensure that you have a driver and GPU
that supports,at,least, CUDA 11.3.1. You can check this with the
nvidia-smiccommand. You should be able to see the supported CUDA
version ir the top right corner of the output.

Wed May 10 11:02:24 2023

NVIDIA-SMI 525.105.17 Driver Version: 525.105.17 CUDA Version:
R e B e +- -
| GPU Name Persistence-M| Bus-Id | volatile Uncorr. ECC
Fan Temp Perf Pwr:Usage/Cap| Memory-Usage | GPU-Util Compute M.
|

R R R R EEEEREEEEERRR RN
® NVIDIA GeForce ... Off | 00000000:01:00.0 On
N/A  50C P8 17W / 86W | 70MiB / 6144MiB

Processes:

GPU GI GPU Memory
1D Usage

69MiB

Figure 39. Output of the nvidia-smi command where the supported CUDA version is displayed
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After checking that the driver and GPU support the necessary version,
the image can be built and run. The process might take around 10-15
minutes to finish.

$ cd docker/gpu

$ ./build_image.sh

$ ./run_image.sh $PATH_TO ROOT_FOLDER
$

cd computer_vision_demo

Note: If the docker installation does not have rootless privileges, the
build_image.sh and run_image.sh files can be edited to_.add the sudo
command before the docker instructions.

3. Device indexing and Access Control Configuration

By default, the configuration for the device indexing and access-control is empty, so that the
object detection and localization demo will not be publishing lecalization data to the server.
If such service is required, then you can use your own a@eployment of the platform by
modifying the missing parameters in the config/device_indexing_defaults.py:

# Keycloak

.KEYCLOAK.URL = "http://IP:PORT"
.KEYCLOAK.CLIENT ID = ""
.KEYCLOAK.SECRET_KEY = ""
.KEYCLOAK.USERNAME = ""
.KEYCLOAK.PASSWORD = "

# ACCESS CONTROL
_C.ACCESS_CONTROL.WRL = "http://IP:PORT"
_C.ACCESS_CONTROL.ORION_URL = "http://IP:PORT"
_C.ACCESS_CONTROL.API_KEY = ""

_C.AGCESSNCONTROL .DEVICE_REGISTRY_URL = "http://IP:PORT"
_CYACCESS_CONTROL.CBROKER_URL = "http://IP:PORT"

Afterdthe parameters have been correctly modified, a service, device and subscription need
todoecreated in order to push data to the server. The following script can be used to do it:

e Locdal

$ pipenv run python3 setup device_ indexing.py

e Docker

$ python3 setup_device indexing.py
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After the execution, a message confirming the service, device and subscription creation
should be displayed in the terminal, as shown in Figure 40.

Creating Keycloak Connection. Timeout: 60s

Connection to keycloak successful

First we make a request to provision a service group for a new device
Successfully provisioned a service group

Successfully registered the device

Successfully created subscription

Figure 40. Terminal output confirming the creation of a service, device and subscriphicp

5.1.2 User guidelines

After finishing the configuration, there is a demo in the repository thet 'can-be used as the
user guideline.

This demo performs object detection using a Deep Learning object'detector network, YoloX,
on a pre-recorded video in the Bosch factory, as well as computes the location of each
object in alocal coordinate system. In more detail:

Object detection: We use the YoloX [32] family-of object detectors, specifically the
Yolo-X model. The model was frained withfa custom-labelled dataset that was
created from videos that were recorded indhesBosch factory in May 2022. The model
detects 3 classes of objects:

o Class O: person

o Class 1: small cart

o Class 2: AGV
Locadlization: Once the positions'@f'edch of the detected objects in pixel coordinates
are obtained, their positionsin-aocal coordinate system in the factory are computed
in meters. To perform a mapping between the pixel coordinate system in the image
and the meter coordinatessystem in the factory, a set of 4 points in the factory and
their respective points inthe image are pre-selected, and an Homography is learned,
i.e., a transformationdhaf*allows to tfransform a point in the image plane to a point in
the factory coordinatesSystem plane.
Save results to cleud: If keycloak and the IDI and IDAC parameters have been
configured properly, the demo also saves the localization data in the device indexing
module.

The demo candbe executed with the following commands:

Local

$=pipenv run python3 demo.py

Docker

$ python3 demo.py

If an output in the terminal just like in Figure 41 is seen, it means that the demo has been
executed correctly.
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Initializing detector...

Initializing localization...

Initializing device indexing client...

Creating Keycloak Connection. Timeout: 60s

Connection to keycloak successful

processing video: 100% ||| ENEENENERRERERRRRRRRDERRRNRRRRRRRNNNENE | o79/679 [04:00<00:00, 2.83it/s]
Saving detection and localization data to CSV

Compressing output video with FFMPEG...

Demo finished!

Figure 41. Terminal output after executing the Computer Vision Device Discovery demgo
Finally, once the demo is finished, it will save several files with the results of the analysis:

e data.csv:Inthisfile, the objects that have been detected and localized.in €ach frame
of the video can be checked. For each entry in the file, the followinglinformation is

available:
o fimestamp: time in which the frame was processedi=in- Unix timestamp
(seconds).

o frame_id: frame number.

o xl.vyl,x2, y2: top left, bottom right corners of the object in absolute [0-width, O-
height] coordinates.

o xl norm, yl norm, X2 norm, y2 norm: tep left, bottom right corners of the
object in normalized [0-1] coordinates.

o score: detection confidence of the sbjeci.

o class id: class of the object. Ois person, lis small_cart, and 2 is AGV.

o x meter, y meter: position of #he, object in the local coordinate system in
meters.

e video.mp4: Video with the bounding bexes, score and class of all detected objects.

Furthermore, if the IDI server was configured correctly and the data was uploaded to it, the
locations stored in it can be redd,\either by accessing all the measurements sent (1
measurement per frame) or thesmneasurements for the last n frames:

e Local

$ pipenv run pYython3’read_historical _data.py --read-all-measurements

n N

$ pipenv run python3 read_historical_data.py --read-last-n-measurements --last-

e Docker

$ python3 read_historical_data.py --read-all-measurements

$ python3 read_historical _data.py --read-last-n-measurements --last-n N

By. default, the --last-n parameter is set to 2. In either case, the format of the data follows, for
eachfframe, the following structure:

“fracking_data": [

{

"locationx"; "7.8",

"locationy": "3.19",

"locationz": "0.00",
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"loctimestamp™: "1970-01-20T11:42:11.350936",

"decawavetime": "27080",
"class_id": "2.0"

"locationx™: "2.14",

|||||

"decawavetime": "27080",
"class_id" "0.0"

5.2 1oT Device Discovery fJWH8)

The installation and user guidelines were provided in D4.3, Section 5.1 [3].

5.3 10T Device Discgveyy (VLP)

The installation and user guidélines'were provided in D4.3, Section 5.1 [3].

5.4 10T Devic&dndexing

The installation @and Gser guidelines were provided in D4.3 [3], Section 5.2, and are also
available on leT-NGIN GitLab repository for IDI [31].

5.51q@T\0Drevices access control

Thé insfallation and user guidelines were provided in D4.3 [3], Section 5.2, and are also
available on 1oT-NGIN GitLab repository for IDAC [24].
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5.6 AR modules / apps
5.6.1 Industry 4.0 (BOSCH Living Lab)

5.6.1.1 Installation guidelines

The AR app for #UC6 has been developed in Unity and to be run on a Magic Leap One
device, with Lumin SDK 2.26.

In order to install the AR app ‘as it is’, its apk can be downloaded (size around 70 MB) from
the project’s Gitlab ( [33]).

Then, on the Magic Leap device, the next steps must be followed:

Install The Lab, which is the main PC application that runs the Magie-€ap device.
Install the necessary tools inside the Lab, basically the DevicesBridge Tool.

Drag and drop the app resources inside any folder of the Magic Leap Device bridge.
Connect Magic Leap to any available Wi-Fi.

Run the App. It is necessary to grant access to the camera,and micro of the device.

LN~

If the code or settings of the AR app need to be modified, then Unity3D needs also to be
installed, and the whole project needs to be cloned.he steps to follow include:

Install Unity hub.

From Unity hub, install Unity 2020 version (any,should work).

Install the version of Unity that supporis’tumin development.

Install MLSDK on your machine (i.e., the SDK of the Magic Leap (ML) Device).
Clone the repo ( [33]).

Open the project.

The scene of this AR app is called ML scene.

Navigate to the scene.

ONOORON -

5.6.1.2 User guidelpies

After running the app.4hg user should wait a little bit while it starts collecting data from the
IDI module or detecting visual targets via the AR camera.

The expected result 45 to observe 3D elements and associated visual information about
sensors / elementsbeing detected. Then, information from sensors in the field of view will be
displayed. Infermation from all detected sensors, inside or outside the current field of view,
will be displayed on the mini map.

The AR appymust be launched from/at a given starting / reference point, which represents
the~erigin of coordinates (0, 0, 0) for every considered discovery and positioning method in
the use case. That origin point is indicated with visual indicators on the floor of the factory.
Afterthat moment, users can freely move while wearing the AR headset and will be provided
with the info about the detected sensors/elements, and with the associated alarms/triggers.

The Magic Leap device and associated AR app have some limits in terms of tracking,
meaning that if the user gets outside of the tracking area, the indoor positioning and any
other positioning methods may fail.

So far, the AR app has been tested in the use case and #UC6 pilot scenario (BOSCH factory),
with satisfactory results. Demo video: hitps://www.youtube.com/watch2ev=IhY{L7mgGjQ
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Finally, it must be remarked that this app has been fine tuned to work inside the BOSCH
factory (#UC6 scenario), so it needs to be configured if it is planned to be used in other
environments.

5.6.2 Indusiry 4.0 (ABB Living Lab)

5.6.2.1 Installation guidelines

The AR app for #UC7 has been created with Unity and can be installed on Android.deviges
following the next steps.

Download the .apk file from the external source onto your Android deviee.

Open the Settings app on your Android device.

Scroll down and select "Security" (or "Privacy" on some devices).

Enable the "Unknown sources" option. This will allow you to install apps from sources
other than the Google Play Store.

Open the "Downloads" app or the file manager app on yeurAndroid device.
Navigate to the folder where the .apk file was downloaded.

Tap on the .apk file to begin the installation process.

Follow the on-screen prompts to complete the installation.

Once the installation is complete, you can laurnch the app from your app drawer or
home screen.

rODdD—

0N O

If modification on code or settings are required, theSe are done the same way as presented
for #UC6 in section 5.6.1 under installation gueidelinés. For proper functioning in other use
cases, the backend service APl endpoints [and identity and access management services
need to be configured.

5.6.2.2 User guidelines

First the app must be opened. Nextstep is to scan a valid QR-code containing the key for
generating model data requést. After scanning, the application should prompt to input user
credentials. Once access is gfanted, it should take a moment for the application fo load the
model and the data. Then the/mobile device's camera should be pointed so that the target
object is visible and affer a few seconds the model tracking is acquired. The Ul is now
enabled and becomes visible, and it is now possible to start selecting different components
or search for specific component. When selected, the component becomes visible, and the
Ul element shows data of the component. The Ul element can be closed for better view.

It should be-nofed that the application has been highly customized for this specific use case.

5,6 RSmart Agriculture/Energy
Unitytogether with Vuforia have been used to create an AR application capable of showing

information of interest relating to a certain detected device on the display of an Android
mobile phone, via HTTP requests to an IDl instance.

5.6.3.1 Installation guidelines

The process to follow in order to install the various components needed for this project is
summarized next.
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A) Download and install Unity Hub. Also, install the version “2021.3.24f1” of Unity from Unity
Hub.

Below is the link to launch the installation procedure: hifps://unity.com/download

UNLOCK YOUR
CREATIVITY

Download the worid's most popular development platform for creating 2D and 3D multiplatform games and interactive
experiences.

L p—— | See other Unity Plans

Starter Success hoips you ship your games faster by removing roadblocks and technical cbstacies, no matier your studio sire.  Discover now

How to get started  System requirements

Create with Unity in three
steps

1. Download the Unity Hub 2. Choose your Unity 3. Start your project
Folo ructions onscreen for version

Figute %2. Unity Download

The version with a free licehsenas well as the underlying Operating System (OS) should be
selected.

The Unity Hub supports the following Operating Systems:

e Windows 7 SP14, 8, 10 (64-bit versions)
e mMacOS$X 10.13+
e CentOS#7
e UbuUniu 18.04, 20.04
For instance, the Instructions for Linux can be found here:

httpssy/ /&OCs.unity3d.com/hub/manual/IinstallHub.himl#install-hub-linux

Once Unity Hub is installed, it should be opened, and the appropriate version of Unity with
Android build support should be installed to build .apk files.
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€ Unity Hub 2.3.2 - o x
Qm o 3 ht
® Projects Installs LOCATE “
®  Learn
& Community @

2019.3.15M

Installs V
Figure 43. Unity Installs A
- m] X

Then, a new project should be created, as shown in Figure 44.

@ Unity Hub 23.2

Qunity o S
> e Projects o
®  Leamn

Project Name Unity Version Target Platform Last Modified Q
&% Community

Give a project name, the 3D template option shodld be selected and "CREATE” should be

clicked, as in Figure 45. O

@ Create a new project with Unity 20193151 - o x

Figure 44. Create o New:nWec‘r (1)

Templates Settings

Progect Mame *

AR loT Switch

e
(&)
e

H | o

30

i

DA

Q CANCEL CREATE

%E Figure 45. Create a New Unity project (ll)
, the project will be created, as shown in Figure 46.
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B 4R 0T Swatch - Untitled - Amdecid - Unity 2015.3.1501 Persenal <DX11 on DXI0 GPUs

File Edit Mssets GameObpect Component Window Help

M - AEEER EEREETE D
= Higrarehy 3§ | = Seene  ooGame ) Azssl Stone
= | Shaded |20 ¢ W |t |=| @0 |8 | X |~ Glzmos |~
v € Untitled i
) Main Camera
7 Directional Light

Figure 46. Unity project created

The scene can be saved through the “File” submenus with,the desired name (e.g., “loT-
Ngin"), as presented in Figure 47.

Projects

Figure 47. Save Unity project

B) Download the Vuforia Engine for your Unity.

It can be installed via Unity Hub itself. To this, a developer account needs to be created at
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https://developer.vuforia.com/

After that, it can be downloaded at: hittps://developer.vuforia.com/downloads/sdk (Figure
48).

engine Home Pricing Downloads Library D
developer portal

SDK Samples Tools

Vuforia Engine 9.1 \/
Use Vuforia Engine to build Augmented Reality Android, iOS, and UWP
applications for mobile devices and AR glasses. Apps can be built with Unity,

Android Studio, Xcode, and Visual Studio. Vuforia Engine can also be

accessed through the Unity Package Manager by adding Vuforia's package
repository with the script below.

. Add Vuforia Engine to a Unity Project or upgrade to the latest
Qunity ; 9 y Proj P9
version

add-vuforia-package-9-1-7.unitypackage (2.57 KB)

AN

Then, the user should login and agree to the terms, as showniin Figures 49 and 50.

Figure 48. Download Vuforia Eng

Login

Login with your Vuforia developer account to download software,
get license keys and participate in the Vuforia community.

N0, SN0 [ X0, com

Mot Registered? Create account now

%ure 49. Login and Agree the Terms (Vuforia)

/7
Q& Software License

In order to continue downloading, you need to agree to the
terms below.

the terms and conditions of the Vuforia Developer
Agreement, which may be found at
httns://develoner viiforia.com/lesalvufaria-develoner-

Figure 50. Software License (Vuforia)

The user should then open the downloaded file in Unity. After that, the user should click on
Import (Figure 51).

i Use of this Vuforia™ Software Development Kit or
extension (the “Software") is subject in all respects to all of
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Import Unity Package B
add-vuforia-package-9-1-7 (1)

¥ - I Editor oo

¥ - [ Migration [

~  # AddVuforiaEnginePackage.cs [P}

~ 3 EditorMigrationScripts.asmdef (e

Al None Cancel ‘Imporl ’

Figure 51. Import Vuforia SDK info Ynity

Now the Unity Software is ready along with Vuforia Engine.
For support, the user may visit this link: hitps://develoger.vyforia.com/support#report-issues

5.6.3.2 User guidelines

As described in the previous subsection, ance the 2021 3.24.f1 version of Unity has been
downloaded and installed from Unity Hubs=enhd the Vuforia Engine for Utility has been
downloaded, we move on to the usersideto carry out the next steps.

STEP 1: Setup Target Image.

Next, a target image is needed."Every time the camera detects this image, the information
of interest will be displayed omihé Android mobile phone display via AR.

For example, the SynField,déviee image (Figure 52) and the EV Charging Station (Figure 53)
as the target images areUsed in this guide.

Figure 52. Example image of the SynField device
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Alternatively, any image of choice could be used (e.g., QRcode, ..

Now, the user should visit h’r’rps://developer.vuforio.com/vuim:op/do’roboses. Then, click
on “Add Database” under “Target Manager” tab. P

Develop Support

Target Manager

Use the Target Manager to create and manage databases and targets.

Q/ . Target Manager Tab in Vuforia

The user should then gi@ name, select device as the “type”, and click on “Create” (Figure
55).
. /
/4

<< Create Database

Database Name *

O Type:
® Device

O Cloud
O VuMark

Figure 55. Create Database on Vuforia
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The user should then click on *Add target” and browse their target image as shown in Figure
56.

10T conrame

Type: Device
Targets (1)
Add Target Downioad Dacabase (Al A

O Target Name Type Rating Status v Date Modified

Figure 56. Add Target in Vuforia

The user should also give a “Width” of their choice (say 4) and a Qe %oy bulb). Finally,

they should click on “Add” (Figure 57). Q
Add Target -
Type:
q 0u @
File:

Jpg or -png (max file 2mb)

Width:

Enter the width of your target in scene units. The size of the target should be on the
Dri8 UTES MEters 31 the defaul
when you upload your image.

Name:
< = )
Name mMust B unique 10 3 daTabase. When & target is detected in your spplication,

/ Cancel Add
Q& Figure 57. Setting Target parameters in Vuforia

The usershould next click on “download Database(All)"”, select Unity Editor and download
(Figur nd 59).
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Download Database

1 of 1 active targets will be downloaded

Name:
loT

Select a development platform:
O Android Studio, Xcode or Visual Studio

® Unity Editor

Cancel Download

Figure 58. Download Vuforia Database to Unity Editor ?&

Compiling Database

 — — — — C)A

Compiling 3 database with Object targets may take several minutes

Cancel

Figure 59. Compiling Vuforia datakgase

Last, the user should double click on the package d@ded and import it in Unity (Figure
60).

o

. loT (1).unitypackage ~ ‘

N .
r@{' ample image
h N

Figu
Import Unity Package

Figure 60. Import package to Unity
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STEP 2: Add screenshot above target image in Unity (AR)

First, the user must open the scene and delete the main camera (just select it and press the
delete key), as in Figure 61.

Copy
Paste
Rename
Duplhicate
Delete ——
Select Children '"‘.9""9"
Select Prefab Root Mok Torget
Creste Empty Cylinder Torget
3D Object > Cloud Recognition >
2D Object > User Defined Target )
B Project Effects > Mode Terget
e Light > Object Target (3D scanned) a
¥ - Favorites Audio » VuMark
g:m Video » Ares Target
O, All Prefal u > Ground Plane >
v @ Assets Vuforia Engine > Mid Air >

/ » B Editor Camers J

Q& Figure 62. Add AR Camera from Vuforia Engine

Nex’r,@%r should add an image target from Vuforia Engine (Figure 63).
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Select Children
Select Prefab Root

Multi Terget

Create Empty Cylinder Target
30 Object > CloudRecognition >
20 Object > UserDefined Target >
Effects > Model Target
Light > Object Target (3D scanned)
Audio > VuMerk

>

>

Figure 63. Add image target from Vuforia Engine O

The user should select “Image target” and, in the inspector pa n'the right side of the
screen, load the image from database (Figure 64). Q

Figure 64. Load Image from Database

Once done, the screen will look something like this (Figure 65):
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Aad Target

¥ ¢ Defaun Trackable Event Handler (Script) e !
Scrige + DetauttTrach able€ ventHander
Cansider target as visble i its status Is
Tracked or Extended Tracked

| On Tarost Feuna 6

Figure 65. Unity screen after having loaded Image from Database V

The user should add a button from the Ul. The user should right click on “Image oxond
select for example “button” from Ul or another selection (Figure 66).

Copy
Paste

Rename

Duplicate
Deete

Toggle
Shider
Select Prefab Root Scrolibar
Dropdown
Dropdown - TextMeshPro

Select Children

Create Empty
30 Object

20 Object » Input Field
Effects > Input Field - TextMeshPro
+ - Light > Canvas
v  Favorites Audio ’ Panel
©, All Materiale Video > Scroll View
&:m u > Event System
l Vuforia Engine >
¥ (@ Assots o
» I Editor M ——
‘ v
'Wé. Add a butfton from Ul
The user should click on # " and change “Render Mode” to “World Space” (Figure 67).

(30 9 W v 00 Do K e Guamos v -

Figure 67. Change Render Mode to World Space

The user user should then set “Event Camera™ as AR camera (simply dragging and dropping),
as in Figure 68.
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World Space
m ARCamera (Camera

Figure 68. Set Event Camera as AR camera V

The user should reset the canvas position to (0,0,0), so that the AR image seeﬂn&hg mobile
phone display (e.g., buttons) is in the same position as the target image @ 69).

Laye

Move to Front
Move to Back

/
& Figure 69. Reset the canvas position

Next, the ould adjust the "screen" of AR over the Target image. The user should rotate
and @ fo fit like this.

~if the target image is run and brought in front of the computer camera, the
shot obtained via AR" will be seen above it (Figure 70).
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Figure 70. AR on QRCode A E
STEP 3: Script for Connection API to IDI services %mo

The user should write a script to get the information especially relQ

e IDI by creating
HTTP requests.

time they frame for example the QRCode (The same is obtained for the invocations to the

The user needs a code that creates a request to the APIs relge the IDI component every
APIs related to the |loT Device Discovery),

create a new C# file with the example name "CliekUr!. or “CallServices” (Figure 71).

W Project &

+ - q
v = Favorites Assets » Scripts
Q. All Materials
Q, All Models

X
O, All Prefabs ‘ # H
ki

First, inside the assets folder, the user should creo’re: w folder "Scripts”, and inside this folder

¥ (@ Assets
» Im Editor
I Resources
I Scenes
I Scripts
» Bm StreamingA

> (&l‘lmash Pi

/ Figure 71. Create a new C# file

The user shm&]dd the following code to the C# file.

. Y
using System. ions;

using .%Hecﬁons.GeneﬂC;
using ine;

V ia;
@ Pro;
usingUnityEngine.Networking;

public class VBTN : MonoBehaviour
{
public VirtualButtonBehaviour Vb;
public GameObject window;
public TextMeshPro olive_fuit;
// Start is called before the first frame update
void Start()

{
Vb.RegisterOnButtonPressed(OnButtonPressed);
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Debug.Log("start");
window.SetActive(false);

}

public void OnButtonPressed(VirtualButtonBehaviour Vb){
Debug.Log("tes pressed");
GetData();

olive_fuit. GetComponent<TextMeshPro>().text = "Olive fruit fly [stage]:" + 64 ;
window.SetActive(true);

} \/
void GetData() => StartCoroutine(GetData_Coroutine()); ?\
IEnumerator GetData_Coroutine() A

{

string url = "https://keycloak.iotngin.lab.synelixis.com/realms/iot-ngin/.well-known/openid-configuratidn;

using(UnityWebRequest request = UnityWebRequest.Get(url))
{
yield return request.SendWebRequest();

if (request.result I= UnityWebRequest.Result.Success)
{
Debug.Log(request.error);
Debug.LogError("errore");
}

else

Debug.Log(request.downloadHandler); %( )
} O

A\

The user should save the code & rn to the Unity screen. Now they link this script to the
AR image. (Just by dragging and-dropping) (Figure 72)

Figure 72. Link a script fo an AR image

The various components of the Unity project created for this use case are displayed in Figure
73.
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Figure 73. Unity Components for the Project

STEP 4: Build an .apk file and test it on an Android Device

Finally, It is fime to build the Android app
The user should go to File > Build Settings (Figure 74)

File Edit Assets GameObject Comp

New Scene Ctrl+N
Open Scene Ctrl+0
Save Ctrl+S
Save As... Ctrl+Shift+S
New Project...

Open Project...

Save Project

Build Settings... Ctrl+Shift+B
Build And Run Ctrl+B
Exit

Figure 74. Build Settings

The usersshould switch to Android. [Click on Switch Platform] (Figure 75)
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Build Settings < |

?&

<
’
wms

The user should click on Player settings and then od€ ’rhe'preferred details / info. App icon
can also be changed from here (for example Figure

Figure 75. Choosing Android in the Buil

Figure 76. Setfting Player Parameters / Info

Then, the %ould click on “Build” (Figure 77).

Q
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Build Settings

lay

Figure 77. Creating d/Build

Finally, the user should give a name to the .@nd save it.

It will start compiling and finish after so imé. Once finalized, the .apk will be created
Figure 78).
(Fig ) Q
This PC > Programs (D:) > AR lot
Name - Date modified Type Size
» || Assets 12-06-2020 22:50 File folder
| Library 13-06-2020 00:00 File folder
» [] Logs 12-06-2020 21:24 File folder
* a Packages 12-06-2020 21:24 File folder
# | ProjectSettings 12-06-2020 23:56 File folder
D QCAR 12-06-2020 22:41 File folder
ﬁhﬁ e
D AR_loT_Switch.apk 13-06-2020 00:00 APK File 29,468 KB

?\\ Figure 78. .apk created
Install'c %:i

run the .apk
Fina l' the .apk must be transferred to the mobile devices, installed and run (Figure 76).
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I : . ) "
N [ ey Sl mperani  bplei s Haly

Figure 79. .apk installed and runriing
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6 Conclusions

This deliverable has provided an update about the technical work and outcomes related to
the design and implementation of components, methods, and tools to provide ambient
intelligence and contextual sensing/actuating in the scope of the EU H2020 IoT-NGIN project.

The document represents the fourth deliverable within the scope of WP4 and, as originally
planned, it updates D4.3 [3], provides final versions of the object recognition methods, and
complete implementations of the AR modules and apps to support the envisioned I0TsNGJIN
use cases.

After providing a comprehensive state-of-the-art review on the IoT-AR field (Section 2), the
deliverable has reported on the final specification for the IDI, IDAC and.loT=AR modules
(Section 3). Then, the deliverable has reported on the evolved versions of visual recognition
/ IDD methods, as well as on the new development of AR tools and metheds/to support the
envisioned use cases: Smart Agriculture, Industry 4.0, and Smart#Energy. Finally, the
deliverable has reported on the installation and usage guidelines far every new and updated
component and tool described in it.

All such components, methods and tools should not onlybe ‘conceived as key ad-hoc
enablers for the envisioned use cases, but as modular and inferoperable pieces to support
advanced and context-aware sensing and actuatingrin the'scope of ambient intelligence
and tactile Internet, via intuitive, natural, and user-friendly multimodal AR interaction
methods. In this context, a set of open-access loT<ARresources (libraries, components, whole
projects, tutorials, courses...) are shared in Annex 1,xapd on public Gitlab repository [1], to let
third-party entities leverage the outcomes of'the,project and further advance in this field.

Future work will be targeted at making use of WP4 component to support the Living Labs as
well as at deploying and running the asseciated pilot actions as part of the envisioned use
cases.
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Annex 1 Public Repo with IoT-AR Resources

Introduction

This Annex collects a set of open-access resources that allow rich interaction with loT sensors
and real-world objects via AR applications. These include both own developments from the
loT-NGIN consortium as well as collected third-party resources (e.g., Github projects, tools,
online courses) that can become for the interested audience in these topics.

The same information included in this Annex is available on the project’s Gitlab [1]y

Resources developed within the project (5)

Resource 1. AR device positioning method in indoor environments

Brief description and purpose of the resource

The AR positioning method for indoor environments is based on-racking where the device
is located within a certain range. To achieve this, image tracking methods are employed,
meaning that whenever the device fracks an image target, the system knows exactly
where the device is located. This method gives very specificiand certain positioning of the
device. Also, this image tracking method is suppo@ed by ‘an additional one based on
placing virtual camera above the player (which is the/device) in Unity3D engine, and
connect the camera movements to the player/dsermovements. By doing this, the position
of the player/user can be known and registered invthe IDI, and/or shown in the minimap.

Code examples / snippets

using UnityEngine;
using Vuforia;
public class IndoorPositioning : Maorf@Beha@viour, ITrackableEventHandler
{
private TrackableBehavialr gfadkableBehaviour;
private bool isTargetDetected = false;
private Vector3 targetPaosition = Vector3.zero;
void Start()
{
trackd®ieBehaviour = GetComponent<TrackableBehaviour>();
i (TlackableBehaviour)

t

trackableBehaviour.RegisterTrackableEventHandler(this);

}
void Update()

{
if (isTargetDetected)
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// Position your virtual object relative to the target position

transform.position = targetPosition;

}
public void OnTrackableStateChanged|

TrackableBehaviour.Status previousStatus,

TrackableBehaviour.Status newStatus)

if (newStatus == TrackableBehaviour.Status.DETECTED | |
newStatus == TrackableBehaviour.Status. TRACKED)

isTargetDetected = true;

targetPosition = trackableBehaviour.transform.position;

}

else

{

isTargetDetected = false;

}
Download URL:

https://gitlab.com/h2020-iots
ngin/enhancing iot tactie £dgtextual sensing actuating/ar-toolkit/ar-tools-info/-

/wikis/home

Dependencies:

These prerequisites offer the groundwork for integrating Magic Leap One, Unity 3D, and
Vuforia-based indoor AR device placement. To create immersive AR experiences indoors,
we use the potent programming environment Unity, the hardware and SDK from Magic
Leap, an@he image identification and tracking tools from Vuforia.

Unity/3D:

¢\ Download and install the Unity 3D program. The version should be 2020.

e / Package for Magic Leap Unity: Add the Magic Leap Unity package that Magic
Leap has made available to your Unity project. The libraries and tools required for
developing for Magic Leap are included in this bundle.

e Import the Vuforia Unity package that Vuforia has given into your Unity project. The
Vuforia SDK and tools for marker-based and image recognition augmented reality
are included in this bundle.

Magic Leap One:
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¢ The actual Magic Leap One AR headset is required for testing and delivering your
Unity application.

¢ Download and install the Magic Leap SDK, which offers the essential APIs and tools
for creating AR applications for the Magic Leap One, from the Magic Leap website.

e Package for Magic Leap Unity's Technical Preview: Open your Unity project and
import the Magic Leap Unity Technical Preview package. Additional Magic Leap-
specific scripts and functionality for the Magic Leap One device integration are
included in this bundle.

Vuforia:

e Account for a Vuforia developer: Register for an account at the VuforiaiDeveloper
Portal.

e License code for Vuforia. From the Vuforia Developer Portal, get’a license key for
the software. To use the AR capabilities of Vuforia in your Unity project, you must
have this key.

e Package for Vuforia Unity: Create a Unity project and impérfithe Vuforia package.
The scripts, APIs, and tools required to integrate Vuforia intodnity are included in this
package.

Installation and Usage Guidelines:
Unity3D:

e Installation: Use the Unity website (https://unhily’com/) to download and install Unity.

e Use: Open Unity after installation, thien start a new project or pick one from your
library. By choosing the package {iles under "Assets" -> "Import Package" ->"Custom
Package," you may import the Magic Leap Unity package and the Vuforia Unity
package into your project.

Magic Leap One:

e Installation: The Magic Ledp SDK must be installed in order to create applications for
the Magic Leap OnheNo download and install the SDK, go to the Magic Leap
Developer Porigh Mitps://creator.magicleap.com/learn/gquides/developer-setup)
and follow the mstructions.

e Usage: Launch yowr Unity project after installing the SDK. By choosing the package
file under "Assets" -> "Import Package" -> "Custom Package," you may import the
MagicLeap Unity Technical Preview package. This package enhances your project
with Mdgic'Leap-specific scripts, settings, and functionality. The Magic Leap One
device may then be used in your Unity project by utilizing the Magic Leap APIs and
functionalities.

Vuforia:

e/ Moke an account on the Vuforia Developer Portal by visiting
https://developer.vuforia.com

e Vuforia License Key: Login to the Vuforia Developer Portal after making an account,
then go to the License Manager area. Get the license key connected to your
project by creating a new license.

¢ Installation: Launch the Unity project. By choosing the package file under "Assets" -
> "Import Package" -> "Custom Package," you may import the Vuforia Unity
package. The Vuforia SDK and required scripts for integrating Vuforia with Unity are
included in this bundle.
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e Use: Enter your Vuforia license key in the "Window" -> "Vuforia Configuration” menu
when configuring Vuforia in Unity. To set up image targets, marker-based tracking,
or other AR capabilities in your project, go to the Vuforia documentation and
tutorials.

Resource 2. Detection of Visual Target from an AR app

Brief description and purpose of the resource

Using Unity3D and Vuforia, we are able to detect many image targets with the AR device.
Vuforia offers Unity3D applications the tools and APIs necessary to..infegrate AR
experiences. Vuforia provides a powerful picture tfracking and recognition solution for
image targefs.

We can make engaging AR experiences in Unity3D that seamlessly“everldy digital material
over real-world objects or photos by utilizing Vuforia's image idenftification and tracking
technology. We can concentrate on creating and implementing the AR interactions and
content within our Unity project while the Vuforia platferm“handles the challenging
computer vision duties.

Code examples / snippets

using UnityEngine;
using Vuforia;
public class DetectTargets : MonoBehayidgrtfréickableEventHandler
{
public GameObject arObject; M The AR object to display when the target is detected
private TrackableBehavioyr frackableBehaviour;
void Start()
{
trackableBehaviogr = GetComponent<TrackableBehaviour>();
if (frackajleBghaviour)

{

frack@bleBehaviour.RegisterTrackableEventHandler(this);

}

GameObject.SetActive(false);

}

public void OnTrackableStateChanged(TrackableBehaviour.Status previousStatus,
TrackableBehaviour.Status newStatus)

{
if (newStatus == TrackableBehaviour.Status.DETECTED | |
newStatus == TrackableBehaviour.Status. TRACKED | |
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newStatus == TrackableBehaviour.Status. EXTENDED_TRACKED)

// Target is detected or tracked, show the AR object
GameObject.SetActive(true);

}

else

{
// Target is lost, hide the AR object
GameObject.SetActive(false);

}
Download URL

https://gitlab.com/h2020-iot-
ngin/enhancing iot tactile contextual sensing actuating/ef-1colkit/ar-tools-info/-

/wikis/home
Dependencies:
Unity 3D:

e The Unity website (hitps://unity.com)) offérs a download and installation of the Unity
3D program. For your particularsoperating system, adhere to Unity's installation

guidelines.
Vuforia:
e Create an acceunt on the Vuforia Developer Portal

(https://developer.vuferiaseom) to use the Vuforia Developer Platform.

e Key for Vuforia ligensey Log into the Vuforia Developer Portal after making an
account, then goytonthe License Manager area. Get the license key connected to
your project by afeating a new license.

e Unity Vuforia package: Add the Vuforia Unity package to your project in Unity. The
Vuforia Developer Portal has the bundle available for download. Go to "Assets" ->
"Import Pagckage" ->"Custom Package" and choose the package file to import. The
Vuforial SDK and required scripts for integrating Vuforia with Unity are included in this
bundie.

Visudl Target Database

¢ \ Create avisual target database by going to the Target Manager area of the Vuforia
Developer Portal. Upload your 3D models or photos as targets to the database.
Once you've added targets. Do not forget to activate and download the
database.

Installation and Usage Guidelines:

1. Using the Vuforia Engine AR package imported from the Unity Asset Store, install the
Vuforia package in Unity3D. Create a Vuforia License Key tied to your project and

88 of 96



https://gitlab.com/h2020-iot-ngin/enhancing_iot_tactile_contextual_sensing_actuating/ar-toolkit/ar-tools-info/-/wikis/home
https://gitlab.com/h2020-iot-ngin/enhancing_iot_tactile_contextual_sensing_actuating/ar-toolkit/ar-tools-info/-/wikis/home
https://gitlab.com/h2020-iot-ngin/enhancing_iot_tactile_contextual_sensing_actuating/ar-toolkit/ar-tools-info/-/wikis/home
https://unity.com/

H2020 -957246 - 1oT-NGIN

leT-NGIN

D4.4 - Enhanced loT Tactile & Contextual Sensing/Actuating (Final Version)

register as a Vuforia Developer. By selecting Window -> Vuforia Configuration from
Unity's menu bar, you may set up Vuforia by inputting your license key.

2. Create the picture targets we'll be using for our AR experience. Image targets are
actual pictures or things that Vuforia can identify and follow. Uploading our photos
and creating target database files (either a.unitypackage or a cloud database) on
the Vuforia Target Manager web page. We insert the target database file that was
produced into our Unity project by double-clicking it or by using the Unity importer.

3. Create an empty GameObject and we add the Vuforia ARCamera component to
it. This is how we use the Vuforia components in Unity. This element controls the
tracking of picture targets and the AR camera.In Unity, we make a newslmdade
Target GameObiject. We select the relevant target from our imported dafabase
and aftach the ImageTarget component to it. To represent the,_confent or
augmentations we want to display when the image target is recegnized, we add
child gameobjects to the image target gameobject.

4. When we start the Unity application on a compatible device, the=vYuforia engine
makes use of the camera to record the actual scene.Using thetarget database
that has been setup, Vuforia analyzes the camera stream and looks for image
targets.Vuforia tracks the location and orientation of an image target after it is
identified.

5. Digital material or augmentations can be shown on tep 6f an image target when it
is being monitored. In our specific case whenewver an image target is fracked by the
AR device, an update of the position of the AR device is processed, and we are
using this method or overlay some informatien” about some packets inside the
factory of BOSCH.

Resource 3. APl REST endpoints forgsan.AR app to communicate with and retrieve
information from the loT Device Indexing module (loT agent database developed in loT-
NGIN)

Brief description and purpose.of the'resource:

The information from loTsghsors is usually stored in an loT agent database or Device
Indexing module. Thisfresource aims to provide a communication channel with such @
module. However, in order to eliminate dependences on the existence of such a module,
the resource is based,on retrieving the information from a CSV file stored on a server, linked
to a specific device/sensor.

This module‘sendsrequest every 0.5 second (configurable) to the database to retrieve the
last valuewpublished in the CSV file and process it accordingly for visualization /
presentation.

GEL /devices Positioning:

e | Retrieves a list of all loT devices and positions that have registered.
¢ Device datareturned as a CSV File, including the device ID, name, status, position.

Code examples / snippets:

using System.Collections;
using System.Globalization;
using System.IO;

using UnityEngine;
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using UnityEngine.Networking;

using UnityEngine . XR.MagicLeap;

public class NewReader : MonoBehaviour

{
public GameObject AGV;
public string csv;
void Start()

{ ? N
MLPrivileges.RequestPrivilege (MLPrivileges.ld.Internet);

MLPrivileges.RequestPriviliege (MLPrivileges.ld.LocalAreaNetwork); O

MLPrivileges.RequestPrivilege (MLPrivileges.ld.LowLatencylightwear); %

StartCoroutine(DownloadFile()); Q 2

}

I[Enumerator DownloadFile() §

| C
while (frue) // Loop infinitely %

{
UnityWebRequest g :P uwr =
UnityWebRequest.Get("http://84.88.36.130:1 abase/test_datagtest_name=pos_prueba_MI
A_09-05-2333");

Debug.Log("'Downloading iI

yield return uwr.SendW est();
if (uwr.result 1= UrQe&questResultSuccess)
{

/
Debu&Error(uwr.error):
) <<
els?
Q %Debug.Log("FiIe downloaded successfully!");

if (uwr.downloadHandler.data.Length <= 0)

{

continue;

Download URL:
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https://gitlalb.com/h2020-iot-
ngin/enhancing iot tactile contextual sensing actuating/ar-toolkit/ar-tools-info/-

/wikis/home

Dependencies: -

Installation and Usage Guidelines: See the Download URL

Resource 4. Display of a mini map of a location on the corner of the field-of-view of an AR
app. with the dynamic information and position of all sensors therein

Brief description and purpose of the resource:

The Minimap aims at guiding the user during the AR experience, by (displaying all the
location of all elements / sensors detected in the physical environmenit onthat mini map.
Besides, the mini map is also useful in combination with the indeorgpesitioning method
(Resource 1), as the AR app’s location can also be displayed, and the information to be
shown could be filtered by distance, sensor type and/or status.

Code examples / snippets:

Download URL:

https://gitlalb.com/h2020-iot-
ngin/enhancing iot tactile contextual sensing actuating/ar-toolkit/ar-tools-info/-

/wikis/home
Dependencies: -

1. Unity.
2. Ascertain REST APl endpoints.
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3. Use UnityWebRequest to send HTTP queries to the APl endpoints, or a third-party
networking library, if Unity's networking features are not sufficient.

Installation and Usage Guidelines:

¢ Installation: UnityWebRequest is pre-installed with Unity and does not need to be
installed separately, meaning there is no need to install nor import any library to
Unity.

e Use: UnityWebRequest is used directly in scripts without the need for any further
processes.

Resource 5. Alarm system when the distance between any two sensors=isibelow a
(configurable) threshold

Brief description and purpose of the resource:

An alarm system is desighed and implemented inside the Unity8D/app targeting the AR
device, where it starts pumping some visual alarm messages in thevfield of view of the AR
device whenever two tracked objects are close (2 m orless). Aldrms could be also auditive
or via vibration. The purpose of this system is fo enhance situdtienal awareness and safety,
trying to avoid accidents.

Code examples / snippets:

using UnityEngine;

public class DetectCollision : MonoBehaviour

{
public GameObject object;
public GameObject object?2;

public string message = "Objects .dre near each other!”;

private void Update()
{
float distance = Vector3.Distance(object1.transform.position, object2.tfransform.position);
if (distance& 2f) // change the value to adjust the proximity threshold

{

DelUg:log(Warning!! you are too close to.....);

}
Download URL:

https://gitlab.com/h2020-iot-
ngin/enhancing iot tactile contextual sensing actuating/ar-toolkit/ar-tools-info/-

/wikis/home

Dependencies: -

e Unity
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Installation and Usage Guidelines:

e Installation: just integrate this feature into an Unity3D project.
e Use: alarms will be automatically received by AR users.

Third-party Resources — Open-source projects (7)

Project 1: A location-based AR app for monitoring outdoor loT sensors

Summary: Location-based mobile AR application for assisting professionals.in conducting
daily inspections on outdoor loT sensors. Among other relevant featuress~the 16T-AR app
allows for: (i) registering new sensors; (i) displaying the locations of sensars and the user on
a map; (i) getting notifications based on.

Demo: hitps://www.youtube.com/waich2v=pVpWK tICZU

Involved Technologies / Components:

Firebase Authentication SDK
Firebase database

Unity, and associated plugins
Vuforia SDK

MQTT Client Library

Link: https://qgithub.com/VivianKuKu/CASAPO228Dissertation Augmented-Sensor

Project 2: A location-based AR app fer monitoring outdoor IoT sensors

Summary: Proof-of-concept project that allows controlling distributed electronic switches
(e.q.. lights) from a smartphone via an AR app

Demo: https://drive.go¥gle.com/file/d/T1UIpIOXssT Xx49pebviX2wzlFHbVLV?b/view

Involved Technelogi€s / Components:

loT Controller (ESP8266)

Unity, and associated plugins

Vuforia-SDK

Artificial Intelligence (Al) Recommendation System

€ink: Rttps://github.com/TMCheah/Virtual-Switch-Controlling-loT-Devices-Using-AR

Project 3: loT-AR Framework

Summary: Open-source framework that eases the integration between AR apps and loT
devices, as well as the transfer of information among them, in real time and in a dynamic
way
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Demo:

S Eemaaee

Involved Technologies / Components:

e Node-RED (https://nodered.org/): programming tool for wiring togetherhardware
devices, APIs and online services.

e Unity, and associated plugins

e HTTP(S) REST API

e MQITT

Link: https://github.com/4m1g0/IOT-AR-Framework

Project 4: Weather conditions and water level inspection,via AR

Summary: Proof-of-concept project to provide realfime data about weather conditions
and water level from loT sensors via an AR dpp

Demo: -

Involved Technologies / Components;

Arduino IDE

Unity

Google Firebase

Flutter

Hardware / Sensors: NodeMCU ESP8266 Wifi Module, DHT-11 Humidity &
Temperature sensor, Rain Drop sensor and Soil moisture sensor

Link: https:/Qithub.com/Mr-Sushant/IoT-AR

Projech5: AR for Preventive Maintenance

Summary: Proof-of-concept project to provide preventive or periodic maintenance for
machines (or robotics) via an AR app. It allows for: (i) displaying specifications and related
information for an associated machine/piece/object or loT sensor; (i) displaying a
simulation of how the machine/piece/sensor works or should work; (i) show how it can be
assembled and/or connected to other elements; (iv) provide a checklist to be monitored
and validated.

Demo: Check demo videos on the Github page
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Involved Technologies / Components:

e Unity
o Vuforia SDK
e Shapr3 (https://www.shapr3dd.com/): 3D CAD program

Link: https://github.com/yudhisteer/Augmented-Reality-for-Preventive-Maintenance

Project 6: AR and loT for Machine Monitoring (Phase Il of Project 5)

Summary: Proof-of-concept project to retrieve dynamic information and pardmeters (e.g.,
temperature, humidity) from loT sensors via an AR app

Demo: Check demo videos on the Github page

Involved Technologies / Components:

Arduino IDE

Unity

Vuforia SDK

Google Firebase

MQTT / HTTP API REST

Hardware / Sensors: NodeMCU, DHT- L1 Humidity & Temperature sensor

Link: https://github.com/yudhisteer/Auggm&nted-Reality-and-loT-for-Machines-Monitoring

Project 7: QR Code scanner forUnity

Summary: Simple QR code seanner implementation for Unity utilizing ZXing.Net QR code
decode/generator librarysBuild for Android/iOS/Windows

Demo: -

Involved Technologies / Components:

e Unity
e /Xing.Net (QR code decode/generator library)

Link: Afse//aithub.com/nickdu088/Unity-QR-Scanner

Third-party Resources — Courses and Tutorials

Online Course

e Platform: Udemy
e Title: Internet of Things using Augmented Reality in Unity
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H2020 -957246 - 1oT-NGIN

leT-NGIN

D4.4 - Enhanced loT Tactile & Contextual Sensing/Actuating (Final Version)

e Duration: 43 lessons, around é6h duration

URL: https://www.udemy.com/course/internet-of-things-using-augmented-reality-and-

unity-iotar/

Tutorials

Summary:

e Tutorial 1) How to integrate IoT-AR to get information from an |oT sensor vig_ an. AR
dashboard, using Unity and Vuforia

e Tutorial 2) How to interact with, and actuate, a switch via an AR app=uJsing Unity
and Vuforia, and a NodeMCU through HTTP requests

Demo:

e Demo 1: https://www.hackster.io/mithun-das/tutoriofadgMented-reality-with-
intfernet-of-things-iot-fo51e7

e Demo 2: hitps://iot4dbeqginners.com/augmented-redlity-based-iot-switch-using-
unity-and-vuforia

Involved Technologies / Components:

Arduino IDE

Unity

Vuforia SDK

MQTT / HTTP API REST

Microsoft VS Code

Hardware / Sensors: NodeMEUNESP8266 Breakout Board - DHT11 Temperature &
Humidity Sensor (4 pins)>Breadboard (generic) - USB Camera - jumper wires
(generic) - Nodemcu LEDwith'Resistor

Link: Check demo URLs
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